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1. Introduction

In this how-to-guide, we build upon learnings from our first guide: Power Bl for Beginners.
If you're new to Power BI, we recommend you start with this first guide if you haven’t done
so already.

We’'ll continue to use sample data from the fictitious Adventure Works bicycle company.
The guide is split into two parts: A and B. In the resources, you can access the .pbix
file (ADW-Part1-Theta) that shows completed steps after part A. This might be useful to

reference your own dataset against if you need to, or if you want to jump to part B.

In part A of the guide, you'll use Power Query to connect, prepare and model data from
multiple Excel files.

In part B of the guide, you'll use Power Bl Desktop to:

e Visualise the data to get a clearer picture about the business based on the facts
hidden in the data.

e Use Quick Measures to extend measures with time intelligence to provide
meaningful insights.

e Get custom visuals.
For terminology, refer to the Glossary in the appendix.

denotes an extra tip or trick you might want to know.

shows where there are instructions to follow.
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Note: If you see a popup window that says, “There are pending changes in your
queries that have been applied. Do you want to apply them”, select yes.

Getting Started

In this section, we discuss Power Bl Desktop, sample data and different phases in
development.

1.1 Power Bl Desktop

Full instructions for downloading Power Bl Desktop are available in our first guide.
Once installed on your local computer, you will be able to connect to different sources,
transform, and visualise your data.

Note: Power Bl occasionally updates its user interface, so screenshots in this guide may
vary slightly to what you see on your screen.

1.2 Sample Data

You will have received the sample files alongside this guide. Although the files are similar
to the ones used in the Beginners Guide, there are some key differences. You must use
these new files for this Intermediate Guide.

e Find the sample files.
e Save the file to your local computer and unzip the content into a folder
that can be accessed by Power Bl Desktop.

* Browse to the saved data files: DimCustomer and AdventureWorks2017. You will
also have ADW-Part1-Theta.

1.3 Power Bl — Phases in Development

Power Bl is designed to be user friendly. Once you connect to a data source, you can
shape and transform the data (remove columns, change data types, and so on), do data
modelling (create relations) and visually present that data.

This guide steps you through the following phases:

e Connect to data sources.
* Shape the data.

* Model the data.

* Report on the data.

Now, let's get started with the Power Bl Desktop tool.
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Part A

You'll need these files:

1. DimCustomer (.csv)
2. AdventureWorks 2017 (.xIsx)

Looking for further Power Bl training for your team?
Check out our training options.

For other data and insights related training, try our
Data Accelerate workshops.
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2. Connecting to Data Sources

2.1 Data Sources

Power Bl can already connect to over 110 different data sources and connection types,
with more being added. As well as connecting to Text/CSV files - like we covered in the
Beginners Guide - some are more complex.

Commonly used Power Bl data sources include:

* File (Excel, Text/CSV, XML, JSON, PDF).
e Database (SQL Server, Oracle, IBM DB2, MySQL, PostgreSQL, Snowflake, etc).
e Power Platform (Power Bl datasets, Power Bl Dataflows, Common Data Services)

e Azure (SQL Database, Synapse Server, Analysis Services, Blob Storage, Data Lake,
Cosmos DB, etc).

* Online Services (SharePoint, Dynamics 365, Dynamics Business Central, Azure
DevOps, Salesforce, Google Analytics, Facebook, GitHub, etc).
e Other (Web, OData, ODBC, Hadoop, Spark, R script, Python script, etc).

The available data sources can be accessed via the Get data button in Power Bl

2.2 Connection Modes

Some data sources allow you to choose the Data Connectivity mode (i.e. connecting
directly to data). There are four options available:

2.2.1 Import

Data is imported into the Power Bl dataset and cached in memory. When you submit
report and dashboard queries to the dataset, it returns results from the imported data.

You must refresh the dataset to get any changes that have occurred in the underlying
data source. This has many advantages, including increased performance and the
ability to work offline.

We used this mode in the Beginners Guide when importing from CSV files. We'll use
the import mode in this guide.
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2.2.2 DirectQuery

Data is not imported into the Power Bl dataset from the data source. Report and
dashboard queries submitted to the dataset will result in new data being returned from
the data source. In this mode, refreshing the dataset is not necessary. Not all data
sources offer a DirectQuery option; for example, CSV files are only available for import,
so we will not discuss this mode in this guide.

Data sources have limitations when using DirectQuery. Details of these can be
found on the Microsoft website here.

2.2.3 Mixed Mode

Mixed mode refers to occasions where data is imported into Power Bl, while some
others are in DirectQuery mode. This mixed mode leans towards more advanced data
modelling in Power Bl, so won't be covered in this guide.

2.2.4 Connect Live

Connect Live is a specific type of connection which only supports SQL Server Analysis
Services (SSAS) databases, either Multidimensional or Tabular models, and Power

Bl Datasets. In this mode, the data model is held by an instance of SQL Server
Analysis Services or in a Power Bl Dataset in Power Bl Service. Currently, when we're
connecting live to an instance of SSAS or a Power Bl Dataset, Power Bl turns into a
data visualisation tool only. Therefore, data transformation and data modelling are not
currently available in this mode. We can create report level measures using DAX when
connected live to a SSAS Tabular instance or a Power Bl Dataset. Connect Live won'’t
be covered in this guide.
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2.3 Importing Data

Let’s get started with importing the data:

* Open Power Bl Desktop as shown in Figure 1 below.

All Apps Documents Web More ¥

Best match
0}

ower ESKIop
App

L power bi

Figure 1: Opening Power Bl Desktop from Windows Search

e When you launch Power Bl Desktop, a welcome splash screen is displayed
* To connect to the sample data for this exercise, select Get data

P oo — "4 WHAT'S NEW
D e S kto p ) Take a look at what's new and improved in
Power Bl in this month's update.
=
W Getdata FoRUMS

Visit the Power BI Forum to ask questions
or interact with other users in the Power BI

W Recent sources

community.
POWER BI BLOG
3 e e Keep up to date with the latest news,
Getting started with Power Bl Desktop resources, and updates from the Power Bl
team.
TUTORIALS
w0j | el [=es
Ready to learn more about Power BI?
sl = v
Building reports Query view concepts. Uploading your reports

+ Get started with Power BI Desktop

[} Open other reports + Download a sample
@ - Watch our training videos
« See what others have built

Creste a Phone report - All guided learning

VIEW ALL VIDEOS.

v Show this screen on startup

Figure 2: Get data from Power Bl Desktop splash screen
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e Alternatively, click the Get data button from the Home tab on the ribbon bar

File ]ns;Modeling View
D s & B8 B

Help

B (& Al dz E

Get™ Excel PowerBl SQL Enter Recent Transform Refresh New Text More ) Quick
datav datasets Server data sourcesv datav visual box visualsv measure measure
Clipboard Data Queries nsert Calculations Share

Figure 3: Get data from the Home tab in Power Bl Desktop

Selecting the down arrow on the Get data button shows the most common data sources
menu. Select More... to open the Get Data dialog.

File Home
= B
Clipboard
1ol
2]

Insert Modeling View Help

Gl B BE R
“Get™ | Excel PowerBl SQL Enter Recent
@i datasets Server data sourcesv
Common data sources

[& Excel

E% Power Bl datasets

@ Power Bl dataflows

[:% SQL Server

[% Analysis Services

[} rexcsv

[B web

[Ebg OData feed

[B Blank query

Figure 4: Most common data sources shows by clicking the down arrow on the Get data button

e Select Text/CSV from the list and click Connect.

Get Data

Database
Power Platform
Azure

Online Services

Other

Certified Connectors

All
A Excel I~
B XML
[ JsoN
Folder
£ PoF
£ SharePoint folder
SQL Server database
[ Access database
SQL Server Analysis Services database
Oracle database
1BM Db2 database
1BM Informix database (Beta)
1BM Netezza
MySQL database

PostgreSQL database

e ‘

Figure 5: Getting sample CSV data
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e Browse to the unzipped data files, select the first file DimCustomer.csv,
and click Open.

l l 5 | ADW_intermediate_v2
File Home Share View
* ?% i Cut ! LE% = l Tiig New item ~ B open
™ Copy path - ] i Easy access z Edit

Pin to Quick Copy Paste Move Copy Delete Rename New Properties
access B Paste shortcut to to - folder - rg History g Invert selection

Clipboard [e]ELTH Open Select
« >+~ R

M Desktop W Name

Downloads *B AdventureWorks2017.xlsx

a DimCustomer.csv

4items |

Figure 6: List of the sample files to be loaded into Power B

* When you click Open, the window shown in Figure 7 below appears,
displaying sample data from the selected file.

File Origin Delimiter Data Type Detection
1252: Western European (Windows) ~ Comma - Based on first 200 rows i ’—‘“
CustomerKey GeographyKey CustomerAlternateKey Title Name NameStyle BirthDate MaritalStatus Suffix Gend
11000 26 | AW00011000 Jon Yang FALSE 6/10/1971 M M
11001 37 AW00011001 Eugene Huang FALSE | 10/05/1976 S M
11002 31 AW00011002 Ruben Torres FALSE 9/02/1971 M M
11003 11  AW00011003 Christy Zhu FALSE  14/08/1973 S F
11004 19 AW00011004 Elizabeth Johnson FALSE 5/08/1979 S F
11005 22 AW00011005 Julio Ruiz FALSE 1/08/1976 | S M
11006 8| AW00011006 Janet Alvarez FALSE|  2/12/1976 | S F
11007 40 AW00011007 Marco Mehta FALSE 6/11/1969 | M M
11008 32 AW00011008 Rob Verhoff FALSE 4/07/1975 | S F
11009 25 AW00011009 Shannon Carlson FALSE | 29/09/1969 S M
11010 22 AWO00011010 Jacquelyn Suarez FALSE 5/08/1969 | S F
11011 22  AW00011011 Curtis Lu FALSE 3/05/1969 M M
11012 611 AW00011012 Lauren Walker FALSE  14/01/1979 M F
11013 543 AW00011013 lan Jenkins FALSE 3/08/1979 M M
11014 634 AW00011014 Sydney Bennett FALSE 6/11/1973 | S F
11015 301 AW00011015 Chloe Young FALSE  26/08/1984 S F
11016 329 AWO00011016 Wyatt Hill FALSE  25/10/1984 M M
11017 39 AW00011017 Shannon Wang FALSE| 24/12/1949 | S F
11018 32 | AW00011018 Clarence Rai FALSE 6/10/1955 | S M
11019 52 AW00011019 Luke Lal FALSE 4/09/1983 | S M v
P
< >

Figure 7: Loading the data to be used

* We have two options, Load or Transform Data. \We want to transform our data,
so we click the Transform Data button.

©theta | Power Bl for Intermediates
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Clicking Load will import the tables exactly as is. This is how we imported the CSV files in
the Beginners Guide. It is still possible to transform the data later by clicking the Transform
Data button from the Home tab in Power Bl Desktop.

¢ Clicking Transform Data opens a separate window - the Power Query Editor:

a powerful data profiling and data preparation tool.

f
t
0. 12 Customerkey -] 123 Geographykey <)% Namesoy | Query Setings X
1 11000 -~ 4 PROPERTIES
2 11001 Name
3 11002 DimCustom
4 11003 All Properties
5 11004
6 11005 4 APPLIED STEPS
7 11006 Source
8 11007 Promoted Headers
9 11008 X Changed Type
10 11009
n 11010
2 11011
1 11012
14 11013
15 11014
1 11015
1 11016
8 11017
19 11018
2 11019
2 11020
2 11021
2 11022
2 11025 298 Awo0011023
2 11024 311 AW00011024 v
2 11005 24 awooon 1075
=< >
27 COLUMNS, 993+ ROWS _ Column profing based on top 1000 rows PREVIEW DOWNLOADED AT 1026 AM

Figure 8: Power Query Editor

* Before we continue transforming data, we need to get the remaining data.
We can get additional data directly in the Power Query Editor by clicking New
Source.

#l | | = | Untitled - Power Query Editor

Home Transform Add Column
w [y B (4
=t LK Lo &

Close & New Recent Enter Data source

Apply~  |Source ¥/Sources~ Data settings P
Close New Query Data Sources |

iac| New Source
Queries - Ts
Create queries by importing data
7] DimQ from a new source.

® Valid
® Error

Figure 9: Adding new data sources

e Select Excel under All or File and click Connect.

X
Get Data
— "
Al & Bl ~
File B Text/csv
Database B M
[#] JsON

Power Platform

Figure 10: Getting data from Excel
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e To import the data, browse to the unzipped data and select AdventureWorks2017
XlIsx then click Open.

¢ A dialog window opens listing the data sources within the Excel file.
Click the checkboxes next to each source and click OK.

o X
Navigator
FactinternetSales B
Display Options ~ Bx | |Productkey  |OrderDatekey |DueDatekey ShipDateKey | Customer Key  Promotion
41 AdventureWorks2017.xlsx 6] 510 20101229 20110110 20110105 21768
% Dimbate 310 20101229 20110110 20110105 21768
346 20101229 20110110 20110105 28389
% [E DimGeography
346 20101229 20110110 20110105 25863
¥ DimProduct 336 20101229 20110110 20110105 14501
% [E DimProductCategory 346 20101229 20110110 20110105 11003
% 3 DimProductSubcategory 511 20101230 20110111 20110106 27645
B FactintemetSoles 510 20101230 20110111 20110106 16524
351 20101230 20110111 20110106 11005
344 20101230 20110111 20110106 11011
© The data in the preview has been truncated due to size limits.
< >
«

Figure 11: Selecting Excel work sheets

We're now connected to the data sources. It's time to profile and transform our data
before creating our data model.

3. Data Preparation with
Power Query

Let’s take a moment to explore the Power Query interface.

The Application Ribbson contains all options and settings. Complete the steps:

Click the View tab from the ribbon. Make sure the following are ticked:
Formula Bar

Column quality

. Column distribution

Note: If show white space is ticked, you can leave as is.

H o~

Help ~ @
4 j [v] Always allow |:E|' E

Transform Add Column

Home

Go to Advanced Query
Column Editor Dependencies
Layout Data Preview Columns Parameters Advanced Dependencies

Figure 12: The Power Bl Desktop application interface

©theta | Power Bl for Intermediates

13



1- Ribbon bar

E‘ Data Type: Whole Number £ Merge Queries

Du First Row as Headers ~

eries [

B3 DimDate
[ DimGeography
[ DimProduct

[ DimProductCategory
B oi
[0 FactinternetSales.

oo

All Properties

—
4 APPLIED STEPS "

375

375 "
e 7- Data transformation
50 steps

750 -
20| ¢ >

[5 COLUMNS, 606 ROWS_ Column profiling based on top 1000 rows y PREVIEW DOWNLOADED AT 11:34 AM|

Figure 13: Enabling some layout and iew items in Power Query Editor

As Figure 13 illustrates, the application ribbons contain all options and settings,
transformations, and other settings configurations.

. The left pane shows different Queries. These can be the tables you selected for
import or custom functions, query parameters, or queries with constant values that
you create in Power Query.

. The Column header shows the column name and data type (Number, Date, Text,
True/False etc).

. The Column quality bar shows details on the number of valid, empty and error
records in the data.

. The Column distribution bar provides counts of distinct and unique values.

. The Data displays the view of the data based on the data transformation step that
has been selected.

. The Data Transformation Steps shows a list of data transformations that have
been applied to the data.

. The Status bar shows the number of columns the selected query from the Queries
pane have, number of rows and data preview refresh date and time.

©theta | Power Bl for Intermediates
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3.1 Splitting Columns

Power Query allows us to split a column into one or more other columns. There are
various options available under the Split Column dropdown.

We will be using By Delimiter to split the Name into First and Last Name.

* Go to the Queries pane on the left and select DimCustomer.

e Select the Name column.

e From the ribbon bar, go to the Transform tab, click Split Column and select

By Delimiter.

i % Data Type: Text ~ E:_-; Merg
I_ _] ['_'_'] Use First Row as Headers ~ zAppe
Split Group 1 -
Column~| By %ReplaceValues Comk
By Delimiter Co
By Number of -
1 . Split Column by Delimiter
By Positions

Split values in the selected column

By Lowercase t

based on the specified delimiter.

By Uppercase to Lowercase 100%
0%

By Digit to Non-Digit

y Lig g 0%

By Non-Digit to Digit

-~

Figure 14: Split column by delimiter

® Valid
® Error
® Empty

¢ |In the dialog box, ensure Select or enter delimiter is set to Space.
e Select Each occurrence of the delimiter and click OK.

Split Column by Delimiter

Specify the delimiter used to split the text column.
Select or enter delimiter

Space -

Split at

O Left-most delimiter

O Right-most delimiter

® Each occurrence of the delimiter

Figure 15: Selecting the delimiter
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e The Name column is split into Name.1 that has the First Name and Name.2 that has the

Last Name. The splitting column by delimiter action above creates a new applied step

as shown in Figure 16 below:

Queries [7] < B, - CustomerAlternateKey - A'c Name.1 \T] Aac Name.2 T] E BirthDate Query Semngs
 ———
I (] DimCustomer Valid 'IDU% ® Valid 100% | @ Valid 100% ' e valid 4 PROPERTIES
. Error ® Error 0% | ® Error 0% ® Error Name
& DimDate Empty ® Empty 0% @ Empty ® Empty

[ DimGeography

[ DimProduct

[ DimProductCategory
O

iz

100 distinct, 1000 unique 427 distinct, 174 unique 9 distinct, 28 unique 914 distinct,

DimCustomer

||||||I||||||| ||||||||||| ||I||| o
"I"" I""""l """ 4 APPLIED STEPS

DimProductSubcategor %
i 1 N00011000 Yang Source
A #*
FactinternetSales 2 00011001 Frerm Huang Promoted Headers
Changed Type
3 N00011002 Ruben Torres
plit Column imiter

4 N00011003 Christy Zhu

22 N00011021 Destiny Wilson ™

23| ( >

28 COLUMNS, 999+ ROWS  Column profiling based on top 1000 rows PREVIEW DOWNLOADED AT 12:32 PM

Figure 16: Column “Name” split to two columns

3.2 Renaming Columns

We will rename the two columns created by the splitting of the Name column. There are

a couple of ways to do this: either double click the Header name or right-click the header

and select rename.

e Double click the Name.1 Header and rename it to FirstName.
¢ Right click the Name.2 Header and rename it to LastName.

A% FirstName |~ | IR INERE P - | X namatrila I~ 1B
—

E® Copy

® Valid 100% e Valid

® Error 0% | ® Error X Remove

® Empty 0% | ® Empty Remove Other Columns
Jon Yang Duplicate Column

Eugene Huang f. Add Column From Examples...

Ruben Torres

R li

Christy P emove Duplicates

Elizabeth Johnson Remove Errors
Julio Ruiz Change Type »
Janet Alvarez Transform 4
M Meht:

arce e }-)z Replace Values...
Rob Verhoff
Replace Errors...

Shannon Carlson

Jacquelyn Suarez rllh - Split Column 4
Curtis Lu = Group By..

Lauren Walker Fill »
lan Jenkins Eﬂ Unpivot Columns

Sydney Bennett Unpivot Other Columns

Chloe Young Unpivot Only Selected Columns
Wyatt il = Rename..

Shannon Wang Move R
Clarence Rai

Figure 17: Renaming Columns
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3.3 Adding Columns

Adding Columns is a common task and there are many ways to do this. There is a
dedicated tab in the Ribbon bar for adding columns. In the next few steps, we use a
Conditional Column and a Column from Example to add new columns.

In the steps below, we will add a new conditional column - TotalChildrenNumber.

1. Go to the Queries pane, select the DimCustomer query.
2. Go to the Ribbon bar, select Add Column, select Conditional Column.

3. In the dialog box, change column name from Custom to TotalChildrenNumber.
4. Modify the If statement to read: If TotalChildren equals one Then 1.
5. Click Add Clause.

6. Add the additional ‘if’ clauses for the remaining values (the values in this

dataset goes up to five. Remember that one is the only value that needs to be in all
lowercase!). *

7. Enter O for Else, this will assign 0 to any remaining records including those
with the value ‘None’.

8. Click OK and our new column will be added.

*Important: Note that Power Query is CAsE sEnSiTive. In this dataset, you'll need to write ‘one’ in
all lowercase. For Two, Three, Four and Five, the first letter will be uppercase.

Add Conditional Column

mn that is computed from the other columns or values.

EPS

d Headers
Type

Jumin by Delimiter
Typel
Columns

28 COLUMNS, 999+ ROWS  Coluniiy profiing based on op T000 Tws

PREVIEW DOWNLOADED AT 1205 PM

Figure 18: Adding a conditional column

Remember to save your work as you go.
In the next steps, we'll add an Annual Income column:

1. From the Queries pane, select the DimCustomer query.
2. Go to the Add Column tab, select the Column from Example dropdown

3. Select From Selection. This adds a new column called Column1 at the end
of the columns list.

4. Select the Yearlylncome column.
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5. In the first row in Column1, type in the same number as is shown on the first row
of Yearlylncome. (Unless the table has been sorted differently, you should type in
90000, note you don’t need to type USD just the numbers.).

6. Press Enter and all the rows will be updated. You may need to enter more rows for
the rest of the column to populate.

7. Rename Column1 to Annuallncome (double click the column title to rename, note
that in some versions of PowerBl your column maybe be renamed “Yearlylncome-

Copy’).
8. Click OK

Eid

olumn From| 2 Invo
Eamples ~_|COMMn
eneral

From All Columns

From Text From Number From Date &Time Al insights

:
[J Add Column From Examples R Q
ename
e Enter sample values to create a new column (Ctrl+Enter to apply). 7 S
1 Transform: Text AfterDelimiter([Yearlyincome, ) 8
] o

(. A% Gender A% EmailAddress PC ‘ML’ A% TotalChildren |Annmunmme]

—

Press Entere

rrrrr

30 COLUMNS, 999+ ROWS _ Column profiling based on top 1000 rows PREVIEW DOWNLOADED AT 2:20 PM

Figure 19: Adding column from example

3.4 Removing Columns

We can remove columns that we no longer need e.g. duplicate columns. This also
applies to columns that are used to add new columns such as the TotalChildren and
Yearlylncome.

You can remove a column that has previously been used to create a new column. It does
not impact on the data in the new column.

* Select the DimCustomer query from the Queries panel.

e Hold Ctrl and click the column headers for Yearlylncome, TotalChildren,
SpanishEducation, FrenchEducation, SpanishOccupation and
FrenchOccupation.

e Right click in any of the selected column headers and click Remove Columns.

B I ol ——
A Yearlyincome A% TotalChildren By Copy

USD 90000 one o

USD 60000 oo > Remove Columns l}
USD 60000 Three Remove Other Columns

USD 70000 None E4  Add Column From Examples...

USD 80000 Five Remove Duplicates

LTI None Remove Errors

2Dl None L, Replace Values...

Figure 20: Removing columns in Power Query Editor
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3.5 Changing Data Types

Each column in Power Bl has a data type. When connecting to a data source, Power
Query loads 1,000 rows of data as sample data and automatically detects the data
types. While in many cases the detected data types are correct, in some cases we may
face data type conversion errors when the detected data type is incorrect. Therefore, it

is advised to always review the data types before continuing with other transformation
steps. For instance, storing a customer number as a number where it should probably be
stored as a text field.

The most common data types and their column icon in Power Bl are:

[ ] ABC
.)2/

.]23

o(D)

oD

Text e.qg. Bicycle

True/False

Whole Numbers e.g. 148

Decimal Numbers e.g. 3.5432

Fixed Decimal Number e.g. 5.45
Percentage e.g. 46.8%

Date e.g. 15/02/2020

Time e.g. 12:35:00 PM

Date/Time e.g. 15/02/2020 10:25:00 AM

In the steps below, you'll make a correction in the automatically detected data types:

* Select the DimCustomer query from the Queries pane.

¢ Go to the TotalChildrenNumber column and click the data type icon.

¢ Select Whole Number from the context menu.

* The data type icon changes to the Whole Number icon.

* Click the data type icon next to the Annuallncome column.

e Select Fixed Decimal Number. This is similar to currency.

e The data type icon changes to the Fixed Decimal Number icon.

e Click the data type icon next to the HouseOwnerFlag column.

e Select True/False.

¢ The data type icon changes to the True/False icon. The O values have been set to
False and 1 has been changed to True.

Figure 21 shows changing the data type of the TotalChildrenNumber.

...

unique

Figure 21: Changing column data types
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3.6 Transformation Steps

All transformations are applied as a series of steps shown in the Query Settings pane as
shown in the Figure 22 below.

Query Settings X

4 PROPERTIES
Name
DimCustomer

All Properties

4 APPLIED STEPS

Source

Promoted Headers
Changed Type

Split Column by Delimiter
Changed Typel

Renamed Columns

Added Conditional Column
Inserted Text After Delimiter
Removed Columns

&Zhanged Type2 J

Figure 22: Transformation steps

It's possible to see the resulting data of each step by clicking on a desired step from the
Query Settings pane as shown in Figure 23 below. This makes it easy to visually inspect
the data after applying each transformation step.

Sezzll < D.m T~ 148 Column2 [~] A% Column3 [~] a8 Columna [T A% Columns | | Query Setings X
] DimCustomer 1 G r " CustomerAlternateKey Title "Name B 4 PROPERTIES
[ DimDate 2 11000 2% AW00011000 Jon Yang
B DimGeography 3 11001 37 AAW00011001 Eugene Huang.
4 11002 31 AW00011002 Ruben Torres
) Ehee 5 11003 1 AW00011003 Chisty Zhu
B DimProductCategory 6 11004 19 AW00011004 Elizabeth John
3 DimProductSubcategory 7 11005 2 AW00011005 Julio Ruiz
[ FactinternetSales 8 11006 8 AW00011006 Janet Alvarez
9 11007 40 AW00011007 Marco Mehta

PV 19,1108 b g2 NS b g g g gEARVegae

Queries [7] < DIW 123 GeographyKey [~] A customerAtternatekey || A8 Title | A8 Name
E DimCustomer 1 11000’ 26 AW00011000 ! "Jon Yang
[ DimDate 2 11001 37 AW00011001 Eugene Huz
B3 DimGeography 3 11002 31/ AW00011002 Ruben Torr
4 11003 11| AW00011003 Christy Zhu Al Properties
(2] Cifietrs 5 11004 19 AW00011004 Elizabeth Jc:
B DimProductCategory 6 11005 22| AW00011005 Julio Ruiz APPLIED STEPS
[ DimProductSubcategory 7 11006 8 AW00011006 Janet Alvar( Source
[ FactinternetSales 8 11007 40 AW00011007 Marco Meh Promoted Headers
9 11008 32| AW00011008 Rob Verhof
10 11009 25 AW00011009 Shannon Cz
1 11010 22 AW00011010 Jacquelyn S

Figure 23: lllustrating the resulting changes of each step in the data

Transformations can be added, edited, removed, renamed, or reordered by right clicking
a desired step from the Applied Steps selector in the Queries Settings as shown in
Figure 24.
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Query Settings

4 PROPERTIES
Name

DimCustomer

All Properties

4 APPLIED STEPS
Source
Promoted Headers
Changed Type
Split Column by Delimiter
Changed Typel
Renamed Columns
X Added Conditinnal Column
Inst Edit Settings
Rer =]l Rename
e X Delete
Delete Until End

Insert Step After

A~ Move before

v Move after
Extract Previous

ew Native Query

&

Diagnose

Figure 24: Renaming, deleting, inserting new step and moving steps

Depending on the data source type, the following transformation steps may already exist
for each query:

1. Source

The very first step of the query is normally connected to the data source. In this
tutorial, the sources will be a Text/CSV source and the Excel Source containing the
other tables.

2. Navigation

If the data source we are connecting to has different objects containing data,
such as an Excel workbook that can contain many worksheets and/or tables, then
by selecting each object from the source system we are navigating through that
object to get the containing data. For each Query, this will be the corresponding
worksheet or table name in the Excel File, while Text/CSV files do not have a
Navigation step as each file contains only one set of data.

3.6.1 Renaming an applied step

The existing steps can be renamed within the Power Query Editor. This shows what the
step did and makes future modification easier. It's highly recommended to rename the
steps to something more meaningful.

¢ Select the DimCustomer query in the Queries panel.

e Right click the Split Column by Delimiter step.

e Click Rename from the context menu and change to Split Name.
¢ Right click the Added Conditional Column step.

* Click Rename and change to Add Total Children Number.
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e Right click the Inserted Text After Delimeter step.
e Click Rename.
¢ Type Add Annual Income.

Figure 25 shows the renamed steps (and the rest of steps we left as is). We've left
those steps for you to rename.

Query Settings X

4 PROPERTIES
Name
DimCustomer

All Properties

4 APPLIED STEPS

Promoted Headers
Changed Type
Split Column by Delimiter
Changed Type1
Renamed Columns
Added Conditional Column
Inserted Text After Delimiter
Renamed Columns1
Removed Columns

X Changed Type2

Figure 25: Renaming steps

3.6.2 Viewing transformation step changes

Select the DimCustomer query in the Queries pane. The Applied Steps pane shows
all steps in the order that they are applied:

1. Click Source to see what the original data looked like. You should see the single
Name column.

2. Click Split Name to see the changes made by this step. The Name.1 and
Name.2 columns should be visible.

3. Click Renamed Columns in the Applied Steps panel and you should see the
columns renamed to FirstName and LastName.

Step: Source

“*  Step: Split Name

Step: Renamed
Columns

Figure 26: Viewing how transformation steps change the data
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3.6.3 Adding a step between an applied step

The steps added earlier to remove columns and change types resulted in new
steps being added to the end of the applied steps. The results of the last step
contain the data that will be imported into the data model and available for
visualisation. You can add a step in between existing steps. Let's add a step that
renames TotalChildrenNumber to TotalChildren, but we’ll add it after the existing
TotalChildren column has been removed.

1. Select the DimCustomer query in the Queries pane.

2. Go to the Applied Steps pane and click Removed Columns.
3. Right click TotalChildrenNumber
4. Select Rename
5. Type TotalChildren and press enter
6. A popup will ask if you are sure you want to insert the step. Click Insert.

@ | [ = | Untitled - Power Query Editor

File Home

Fd El

Examples~ Column

General

Queries [7) <

Transform

Ei

Column From Custom Invoke Custom
Function

ID DimCustomer I 0ﬂ. *hone

[7] DimDate

7] DimProduct

[ FactinternetSales

[T DimProductSubcategory
[Z] DimProductCategory
[T DimGeography

Queries [7] <

] DimCustomer

7 DimDate

7 DimProduct

T FactinternetSales

7 DimProductSubcategory
7] DimProductCategory
7 DimGeography

Nl v s |lw v -

ol o ~Nlaoluaslwiv|=

=)

- X
AddColumn  Vier > (]
[ Conditional Column AN —
L ! iC — @
r Jf Index Column ~
. ma’ Date  Time Duration Text  Vision Azure Machine
(7] Duplicate Column’ » H S Analytics Leamning
. From Date & Time Al Insights
fx » "TotalChildren", "Spanishtducation”, v Q“ery Settings X
ﬁv\” 4 PROPERTIES
TotalChildrenNumj’ B Copy 9
N w Name
alid WValid x Remove DimCust
5 imCustomer
rc: Erro: Remove Other Columns &
m mj
Py p=mPLY Duplicate Column All Properties
4 Add Column From Examples...
4 APPLIED STEPS
j Remove Duplicates
Source
Remove Errors
distinct, 562 unique Promoted Headers
) 500 555-0162 > Change Type Changed Type
) 500 555-0110 Transform Split Name
) 500 555-0184 4, Replace Values... Changed Type1
) 500 555-0162 Replace Errors... Renamed Columns
) 500 555-0131 =, Group By... Add Total Children Number
) 500 555-0151 Fill Add Annual Income
) 500 555-0184 S5 Unpivot Columns Sanamad.Colun
) 500 555-0126 Unpivot Other Columns 9 X Removed Columns
) 500 555-0164 - Unpivot Only Selected Columns anged Type
mran > e} @)
) 500 555-0169 » Move
fx = Tab? k{ome“, "TotalChildren", "Spanishtducation”, v Query Settings X
e <17 S [ rotaichitaren 1 kfePincome -] 4 PROPERTIES
: Name
alid 100% ‘% ® Valid 100% | e Valid 100%
rror o-;) B | e Error 0% Error 0% DimCustomer
TOWS ot | m s POV PP
mpty o - . % All Properties
X
Insert Step 4 APPLIED STEPS
. . . . Source
sistinel Are yofoJ sure )k;ou want to msevt; s;ep? :gsemng an mtermedxa;e st:p e D
) 500 5: may affect subsequent steps, which could cause your query to break. N Changed Type
) 500 54 Split Name
) 50058 @ Changed Type1
) 500 5¢ Renamed Columns
) 500 SSomwasw — BUVUU Add Total Children Number
) 500 555-0151 0 70,000 Add Annual Income
) 500.555-0184 020,000 Repamed Colymns1

Figure 27: Inserting a step between existing steps in the Power Query Editor
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You should see a step called Renamed Columns2 is added between Removed
Columns and Changed Type2. Don'’t worry if you see an error, we are about to fix that!

« || Query Setiings X
* 455 TotalChildren ~| A8 Annualinc 4 PROPERTIES
Name
® Valid 100% e Valid
o 'a
® Error 0% | ® Error DimCustomer
® Empty 0% e Empty

All Properties

‘ | | 4 APPLIED STEPS
i | soure

16 distinct. 0 u Promoted Headers
4] 90000 A Changed Type
0 60000 Split Name
0 60000 Changed Typel
0 70000 Renamed Columns
0 80000 Add Total Children Number
0 70000 Add Annual Income
0 70000 Renamed Columns1
0 60000 Removed Columns
0 60000 > Renamed Columns2
0 70000 Changed Type2
n 70nnn

Figure 28: A new step is added between existing steps

3.6.4 Reordering applied steps

You can change the order of the steps by dragging and dropping a step to another
location.

Be careful when reordering steps as it may have a negative impact on future steps that
depend on the moved step.

e Select the DimCustomer query in the Queries panel.

e Click and drag Add Annual Income and drop it above Add Total Children
Number. This step will now take place before the Add Total Children
Number step.

4 APPLIED STEPS

Source

Promoted Headers

Changed Type

Split Name

Changed Typel

Renamed Columns

Add Totar Chilares Nuvober Ls
X Add Annual Income

Figure 29: Moving existing steps up or down
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3.6.5 Editing an existing step

All existing steps can be modified. If there’s a settings icon # to the right of the
name, you can edit the step from the Ul. Otherwise, you can modify the existing

steps from the code - either by opening the “Advanced Editor” or from the “Formula
bar” (if enabled). Before we look at editing existing steps, let’s see how we open the

“Advanced Editor” and how we can enable the “Formula bar”.

* You can access the “Advanced Editor” from various places. You can right click
a query then click “Advanced Editor”. You can alternatively click the “Advanced

Editor” button from the “Home” tab.

< m. [ customerey.

— _
® com

[ DimDate Paste

[ DimGeography
[ DimProduct
[ DimProductCatego

[ DimProductSubeate
B FactintemetSales

Figure 30: Opening “Advanced Editor”

e Enabling Formula bar is easy. It's beneficial as it can help you to understand
and learn how Power Query works. Clicking each step allows you to see and
modify the Power Query expressions.

So, for those columns that cannot be edited, using the Formula bar is handy. To
enable the Formula bar, click the corresponding tick box from the
View tab as shown in the Figure 31:

Home Transform Add Column m

EI] Formula Bar

Layout Data Preview Col

Tools Help‘

mn distribution

=

Query

[] show whitespace [ | Column profile
Go to
[v] Column quality Colu

Figure 31: Enabling Formula bar from the Power Query Editor
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Note: In section 3.6.4, we renamed the TotalChildrenNumber column to TotalChildren. This
breaks the Changed Type2 step. You'll see an error message | # on the Queries Panel to the
left. To fix this error, we have to:

e Click the Changed Type?2 step.
e From the formula bar, replace the words TotalChildrenNumber with TotalChildren.

e Click the Commit button as shown in Figure 32, in some versions of PowerBl this
may happen automatically.

Replace TotalChildrenNumber

/_\ with TotaiChildren

< x 6;, - Test Renames Cotumsi®, ((-TRRRICRANERNA", Intes.Type), A || Quary S
\) {*2nnsallncone”, Currescy.Type), (“HeuseOwserflag”, type logical)}) 4 PROPERTIES

Nare
- s Comemerkey <] 12y Gecprseikey ZJak oo e -A-(m.\..-(..,m.... opertes
o vosa oo~ oo » vate N e
o ™ | o Emee o v
. m | o enp o o8
¢

4 APPUED STEPS.

0% o Vabs

Figure 32: Edit steps from the Ul (when applicable)

3.6.6 Deleting an applied step

All steps can be deleted except the source steps. You can either delete just the
selected step or all steps from that one until the end.

Be careful when deleting steps. It may have a negative impact on future steps
that depend on the deleted step. Power Bl will give you a warning when you
attempt to delete any steps.

In this instance, you don’t need to delete any steps.

Query Settings X

4 PROPERTIES
Name

DimCustomer

All Properties

4 APPLIED STEPS

Source .

Promoted Click to

o delete the
Total Children Number

@: Annual Income

ed Columns

Figure 33: Deleting the steps
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In this chapter, you learnt some data preparation steps like splitting columns, renaming
columns, adding new columns, changing data types and so on. Once you've completed
the required transformation steps, you can load the data into the data model. In the next
chapter, we look at the basics of data modelling.

4. Modelling the Data

Data modelling is one of the most important aspects of data analysis, regardless of

the tools we use, and Power Bl is not an exception. After we import data into the data
model, we need to create and manage relationships, creating analytical calculations and
implement the business logics available for data visualisation. Here are the basics of data
modelling.

4.1 Relationships in Data Modelling

Relationships between tables are necessary to accurately calculate the results and
visualise the correct information in the report. When we create a relationship between two
tables, we are creating a linkage between the data stored in those tables in one of the
following ways. Let’s imagine we have two tables, Table X and Table Y:

e A row of data from Table X is related to one and only one row of Table Y. This type
of relationship is called a One-to-one relationship. Like when we stored the
personal details of a customer in a table called Customer and we stored the
customers’ address in a table called Address and a customer has only one
address.

e A row of data from Table X is related to many rows from Table Y. This type of
relationship is called a One-to-many relationship. In our previous example, a
customer can have many sales orders, so if we stored the sales orders in a Sales
table, then each customer from the Customer table relates to many rows of sales
data from the Sales table.

e A row or data from Table X is related to many rows of data from Table Y AND a
row of data from Table Y is related to many rows of data from Table X. This type of
relationship is called a Many-to-many relationship.

Now that you know about the different types of relationships in Power Bl, let's see how to
identify the columns contributing to a relationship.

4.1.1 Identifying Key Columns in Power Query

To be able to create a relationship, we firstly need to identify the key columns in both
related tables. There are two types of key columns, Primary Key and Foreign Key.
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4.1.1.1 Primary Key

In data modelling, we refer to tables as Entities. A table consist of columns holding
the data. Each column describes an Attribute of an Entity.

The columns (attributes) hold the data that describe Records of columns
(attributes).

Each record of data in a table (entity) is a row.

For instance, in a Product table (entity), the columns (attributes) of the table
contain the product data. Each row (record) of data describes a single product.

In data modelling, we normally have a column or a combination of columns who can
describe a unique row, hence we do not need to mention all columns to describe a
single unique row (record) of data. The column or columns that describe a unique
row are so called Primary Key columns. The primary keys consist of combination of
columns are so called Composite Keys.

In Power Bl, Composite Keys are NOT supported, therefore we must have one
primary key column only. It is NOT mandatory for all tables to have a primary key
column. At this stage you may ask “well, how can we identify the primary keys
then?”. The answer is that it depends. In many cases, the tables in the source
system already contain a column that has a Key or ID in the column name,
especially if the source system is a relational database like SQL Server, Oracle etc.
But there are still many other cases that you do not have that option, therefore, you
may need to find the primary key columns yourself. Let's have a look at an example
and find the primary key of the Customer table from the sample file provided with
this guide.

Follow the steps below:

e |f you previously closed the Power Query Editor and you are back to the
Power Bl Desktop window, go to the Home tab and select the Transform data
button to open the Power Query Editor. Otherwise jump to the next step.

* Go to the View tab and make sure that Column Distribution is ticked.
This will show a new box on top of each column below the column title.
This box is called Column Distribution Box.

¢ | ook at the Column Distribution Box to find a column that has the most
unique and distinct values. Hover-over each column’s distribution box and
look at the Distinct % and Unique % values in Figure 34 below:
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Figure 34: Identifying Primary Key using Column Distribution feature in Power Query

As you see in Figure 34, there are currently two columns that can be primary keys
for the DimCustomer table. In cases like this, we need to have a good level of
understanding of the business to be able to pick one of those columns as the
primary key column. In this case, we already know that the CustomerKey column

is indeed the primary key of the DimCustomer table. Therefore, we will use the
CustomerKey column when we want to create a relationship between this table and
other tables in the data model.

Important Notes:

* The method mentioned above is just to identify the Primary Key column of the
tables.

¢ The Column Distribution information is based on top 1,000 rows of sample of
data as shown in the status bar in the Power Query Editor window in Figure
35. If we have more than 1,000 rows of data in the underlying table,
which in our example we do, the Column Distribution information is not very
accurate.

* To make the Column Distribution information more accurate, we have to
change the column profiling data to be calculated based on the entire dataset
as shown in Figure 35. Select this by clicking on the footer.
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Figure 35: Changing column profiling sampling data
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4.1.1.2 Foreign Key

So far you learned what Primary Keys are. When we have a Primary Key of a table
in another table, then that column is called Foreign Key. It is NOT necessary that
the foreign keys contain unique values.

You've now finished using Power Query. You need to save the data that you have
worked on.

e Save what you have done in Power Query. Go to file and save as ‘ADW-Part1’
¢ Apply all changes
e Exit out of Power Bl

When we resume in part 2, you will need to use the new file that you have saved
‘ADW-Part?’.

If you're jumping straight into part 2 of the guide, or you were unable to complete
part 1, you should use the supplied file ‘ADW-Part1-Theta’. This should match the
one that you've just created (providing all the steps in this guide were completed
successfully).

Introduction
- Part B

In Part B of the guide, we jump back into Power Bl Desktop.

Some notes before we get started:

You'll see that we've highlighted expressions in grey boxes. You can copy/paste
these, but we’d recommend retrieving them from GitHub as it preserves the correct
formatting. Access the expressions in GitHub here.

If you're copy/pasting expressions, you must ensure that the code copies straight
speech marks " as opposed to curly speech marks “. Curly speech marks in the code
will not work!

Part B explains more concepts around Power Bl. To make it easier to follow, you

can jump to the yellow highlighted sections; these show the instructional steps to take.
Part B uses the dataset from where you finished in part A. If you need to access the
completed dataset from Part A (e.g. if you're starting from Part B or you had issues
completing part A), use the supplied file ADW-Part1-Theta.
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Part B

You'll need:

1. Saved dataset from part A (ADW-Part 1)
OR Theta’s supplied .pbix file (ADW-Part1-Theta)
2. Access to the GitHub repository

How are you getting on? If you need a bit more ‘hands-on’ help, try our
Power Bl team training.

For other data and insights related training, take a look at our
Data Accelerate workshops.
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5. Understanding relationships
in Power Bl

We always create relationships between the Primary Key of a table and its
corresponding Foreign Key in another table. Let’s look at our imaginary tables - Product
and Sales - to get a better understanding of the relationships.

Product Sales
ProductKey Product Name ProductKey | Sales Amount $ | Sales Date |CustomerKey
1 Laptop 1 2,000 7/01/2020 |1
2 Mobile 1 1,500 8/01/2020 |2
3 Mouse 1 980 9/01/2020 |2
2 550 7/03/2020 |2
3 50 7/02/2020 |3
3 65 6/01/2020 |2
2 890 12/03/2020|1
1 3,500 22/02/2020|1

Figure 36: The structure of Product and Sales tables

In Figure 36 above, the ProductKey column is the Primary Key of the Product table and
a Foreign Key in the Sales table.

We create a relationship between Product and Sales using the ProductKey column

in both tables. As you can see in Figure 36, every single value of ProductKey from

the Product table has many corresponding values in the Sales table; the relationship
between the two tables is a One-to-many relationship. Creating a relationship between
the two tables will look like Figure 2: the (1) resembles the One side of the relationship
and the (*) resembles the Many side of that relationship.

Product Sales
ProductKey Product Name ProductKey | Sales Amount $ | Sales Date |CustomerKey
1 Laptop . 2,000 7/01/2020 |1
2 Mobile 1,500 8/01/2020 |2
3 Mouse 980 9/01/2020 |2
550 7/03/2020 |2
50 7/02/2020 |3

2
1
1

65 6/01/2020

890 12/03/2020
3,500 22/02/2020

.
BPIN W WwiN|RR| e

Figure 37: One-to-many relationship between Product and Sales tables

Let’s add another set of tables to our existing set of imaginary tables, Customer and
Customer Address:
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Customer Customer Address
CustomerKey | Name CustomerKey | Address
1 John Doe 1 #1 Street 1
2 Jane Doe 2 #2 Street 1
3 Joe Simpson 3 #1 Street 3

Figure 38: The structure of Customer and Customer Address tables

As Figure 39 illustrates, each customer from the Customer table has one and only one
corresponding address in the Customer Address table. Therefore, the relationship
between the two tables is a One-to-one relationship.

Customer
CustomerKey | Name
1 John Doe 1 Customer Address
2 Jane Doe —é— CustomerKey | Address
3 Joe Simpson 11 #1 Street 1
2 #2 Street 1
3 #1 Street 3

Figure 39: One-to-one relationship between Customer and Customer Address tables

Customer
CustomerKey | Name
1 John Doe

! Customer Address
2 Jane _Doe % Customerkey | Address
3 Joe Simpson 11 #1 Street 1

H 2 #2 Street 1
o 3 #1 Street 3

Product Sales

ProductKey Product Name ProductKey | Sales Amount $ | Sales Date |CustomerKey
1 Laptop 1 2,000 7/01/2020 |1
2 Mobile + 1 1,500 8/01/2020 |2
3 Mouse AE 980 9/01/2020 |2
2 550 7/03/2020 |2
3 50 7/02/2020 (3
3 65 6/01/2020 |2
2 890 12/03/2020(1
1 3,500 22/02/2020|1

Figure 40: Creating one-to-many relationship between Sales and Customer

5.1 Creating Relationships in Power Bl

Power Bl is not only a reporting tool. It's an analytical tool that you can create data
models with. The data model in Power Bl includes tables and their relationships.
There’s a specific tab in Power Bl called the Model View - placed in the left pane of the
Power Bl Desktop as shown in Figure 41.

File Home Help

15 & [

Get Exc

datav

Figure 41: The Model view tab in the laft pane in Power Bl Desktop
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So far, you've learnt about Primary Keys, Foreign Keys and relationships. Power Bl can
also create the relationships between tables. However, it sometimes detects incorrect
relationships; we must review the automatically generated relationships from the Model
view. Follow these steps:

* Go to Power Bl Desktop.

* Go to file, open report and select the file that you saved at the end of part 1 of the
guide. ‘ADW-Part1.pbix’ (or access our supplied file ADW-Part1-Theta).

* Go to the Model view. Some relationships have been automatically created
between a few tables. Note that your data model may be arranged differently.

Figure 42: Power Bl automatically detected some relationships

The arrows on the relationships indicate which direction filtering will occur. In Figure 43,
if we put a filter on a value of a column from the DimCustomer, the FactInternetSales will
only show records related to the selected value.

I DimCustomer

3 Addresslinel

73 CarrierTrackingNumber T8 Addressline2

" FactinternetSales

1 CurrencyKey 3 Annualincome

&3 CustomerKey [T} BirthDate

T3 CustomerPONumber ) CommuteDistance

&3 DiscountAmount [T CustomerAlternateKey
T DueDate 3 CustomerKey

&3 DueDateKey T8 DatefirstPurchase

71 ExtendedAmount 1 EmailAddress

£ Freight {3 EnglishEducation

Tl OrderDate 3 EnglishOccupation
&3 OrderDateKey [T} FirstNam

Figure 43: The direction of filtering from DimCustomer to FactInternetSales
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Figure 42 showed that not all relationships have been automatically detected by
Power Bl; we’ll need to create the rest of them manually. Follow the steps:

1. Click the Manage Relationships button either from:
A. The Modelling tab from ribbon bar
B. Or the Model view tab from the left pane

C. Or the Data view tab from the left pane under the Table tools tab from the
ribbon bar (Figure 44).

PowerBlintermediate - Power Bl Desktop

View External Tools

Help

CREA
QBA Language Linguistic
setup v schemav

f%[‘*n[?z[‘*@@[%

Get Excel PowerBl SQL Enter Recent | Transform Refresh
3 at

P =) 8% A B

Manage View Q&A Lan T Lin oo jstic | Publish
rol

PowerBlintermediate - Power Bl Desktop

file ~ Home Help  External Tools

<D Name | DimCustomer @

Mark s date
table v

11471 207 AW00011471 Latasha Suarez
11600 218 AW00011600 Linda Rubio

11614 172 AW00011614 Katrina Sharma
12378 121 AW00012378 Brianna Sanchez
12379 147 AW00012379 Bridget Chande

P gt ZG| | ISPNNOOLSTS i S ghaiy

Figure 44: Accessing the Manage Relationships button in Power Bl Desktop

2. Select the New... button from the Manage relationships window.

3. Select DimProduct from the first dropdown box.

4. Highlight the column ProductSubCategoryKey.

5. Select DimProductSubCategory table from the second dropdown box.
6. Highlight the column ProductSubCategoryKey.

7. Ensure the cardinality is set to Many to One (*:1).

8. Leave the Cross filter direction to Single.

9. Make sure the Make this relationship active is ticked.

10. Click OK, then close the window.

Figure 45 shows these steps.
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Dime:

Factinternetsales (Productkey) DimProduct (ProductKey)

X
Manage relationships
Active From: Table (Column) ‘To: Table (Column)
v
v (Pr te Key) | DimProduct( (Pr te Key)
v
v

x | e

Create relationship p—

Select tables and columns that are related,

10

SafetyStocklevel  ReorderPoint  ListPrice  Size
1000 750 NULL NULL
1000 750 NULL NuLL
1000 750 NULL NULL

<
DimProductSubcategory
Cardi

5
6
\d

Many to one (*:1)

@

—

Figure 45: Adding a new relationship

We’'ll create the final relationship in an alternative way. Follow this step:

1. Drag the OrderDateKey from the FactinternetSales table and drop it over the
DateKey Column of the DimDate table.

Figure 46: Creating relationship from the Model view by dragging and dropping a key column

After creating all relationships, your model should look like Figure 47.

Figure 47: The Model view after creating relationships
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5.2 Creating Calculated Columns and Measures
with DAX

A data model consists of Tables and their Relationships. There are also other elements
included in the data modelling:

1. Calculated Tables
2. Calculated Columns
3. Measures

All these can be created programmatically using DAX. In the next few sections, we look

at them in more detail.

5.2.1 Calculated Tables

On some occasions, you need to add new tables based on data you've already loaded

into the model. These tables can be created using DAX.

You can also use table constructor in DAX to create a calculated table. Table
constructor isn’t a function; it's a set of characters that allow you to create a table in
DAX. For example, the following DAX expression creates a table with one column

(Figure 13).
Calculated Table 1 =
{”A”, ”B”, IICU}
V= PowerBlIntermediate - Power Bl Desktop
File Home Help External Tools Table tools f
o
El i
@ e [Clcamsa i 1] A B E
Manage New Quick New New /
relationships | measure measure column table >
Structure Calendars Relationships Calculations
ol X |1 Calculated Table 1 =
2 ‘ {"A", "8", "C"} (
B vale [~ {
A |
ig B 4
¢ ¢
P eV D R S

Figure 48: Creating a calculated table with one column using table constructor
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You can use curly brackets {} to construct a table. This is a simple form of using table
constructor in DAX. Here's how it works:

e Start of table construct - open curly bracket {
e “A” “B” and “C” are the values of a single column
e End of table construct - close curly bracket }

You can use any scalar DAX expressions in the values. The example below creates
another calculated table using the table constructor and the DATE() function:

Calculated Table 2 =
{DATE(2020, 7, 22), DATE(2020, 7, 23), DATE(2020, 8, 2)}

Figure 49 shows the results of running the above DAX expression (you don’t need to
complete this as a step).

PowerBlIntermediate - Power Bl Desktop

File Home Help External Tools Table tools

B o=
@ o [creomesoes | E B H
Mark as date Manage New  Quick New New
table v relationships | measure measure column table
Structure Calendars Relationships Calculations /
Nl X v |1 Calculated Table 2 = 3
2 {DATE(2020, 7, 22), DATE(2020, 7, 23), DATE(2020, 8, 2)}
E Value - /
22/07/2020 12:00:00 AM
23/07/2020 12:00:00 AM f
2/08/2020 12:00:00 AM y
PR SN Ry S

Figure 49: Creating calculated table with DAX table constructor using DATE() function

The following DAX expression is another structure of table constructor: when you
define rows of data records using parentheses () where the values are separated with

comma. As you see in Figure 50, you can use constant values or scalar expressions to
define the rows.

Calculated Table 3 =
{
(“A” 1.5, DATE(2017, 1, 1), CURRENCY(199.99) ),
(“B" 2.5, DATE(2017, 1, 2), CURRENCY(249.99) ),
(“C" 3.5, DATE(2017, 1, 3), CURRENCY(299.99) )

}

Figure 50 shows the results of running the above expression in Power Bl:
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=) PowerBlIntermediate - Power Bl Desktop

File Home Help External Tools Table tools y
E A |
&) Name | Calculated Table 3 @ @ @ @ 4
N o
Mark as date Manage New  Quick New New
table v relationships | measure measure column table <
Structure Calendars Relationships Calculations )
[ X |1 Calculated Table 3 = -
2 4
E 3 ( "A", 1.5, DATE(2017, 1, 1), CURRENCY(199.99) ),
4 ( "8", 2.5, DATE(2017, 1, 2), CURRENCY(249.99) ), /
S ( "C", 3.5, DATE(2017, 1, 3), CURRENCY(299.99) ) (
&8 6 |8 <
Valuel |~ | Value2 |~ Value3 ~ | Valued |~ .
A 1.5 1/01/2017 12:00:00 AM 5199.99 b
-
B 2.5 2/01/2017 12:00:00 AM 524999
C 3.5 3/01/2017 12:00:00 AM 5299.99 /
Y Y PO o NI SR * A),
—— amadlt R - -

Figure 50: Creating a calculated table with DAX constructors using constant values or scalar expressions

As above, when defining the rows in the table constructor, the default column names
are specified as Value1l, Value2, Valueg,...

We previously stated that we can also use any DAX functions that result in a table
value. There are many use cases for that. For example, if you want to create a
calculated table to show:

e The customers’ full name - which is the concatenation of their first name
and last name.

e Their total sales.
e Where the country region is Australia.

To create a calculated table, click the New table button from the Modelling tab from
the ribbon (You need to have the data view tab highlighted in the leftpane). Then use

the following DAX expression in the expression box. These steps shown in Figure 52:

Australian Customers Sales =
SUMMARIZECOLUMNS (

DimCustomer[CustomerKey]

, FILTER(

VALUES(DimGeography[EnglishCountryRegionName])
, DimGeography[EnglishCountryRegionName] =“Australia”)

,“Customer Full Name”, CONCATENATEX(DimCustomer, DimCustomer[FirstName] & ““ &
DimCustomer[LastName])

,“Sales Amount”, SUM(FactinternetSales[SalesAmount])

)

Figure 52 shows the results of running the preceding expression.

©theta | Power Bl for Intermediates

39



In Figure 51, the table has only 3,591 rows while the original DimCustomer table has
more than 18,000 rows.

External Tools

View

File Home Insert Help

Bg P I A
=] ey
& A % Q AR e A t

Manage New = hange New Manage View Q&A Language Linguistic
relationships = meg#lie measure column| parameter roles  as setup v schema v

Q&A

What if Security

Calculations Page refresh

Relationships

ol X

Australian Customers Sales =
SUMMARIZECOLUMNS |(

B DimCustomer[CustomerKey]
i, FILTER(

B VALUES('DimGeography ' [EnglishCountryRegionName])

, 'DimGeography'[EnglishCountryRegionName] = "Australia”)

, "Customer Full Name", CONCATENATEX(DimCustomer, DimCustomer[FirstName] & " " &
B DimCustomer[LastName])

, "Sales Amount", SUM(FactInternetSales[SalesAmount])

-~

223
=

ADW-Part1-Theta (1) - Power Bl Desktop

File Home Help Table tools

o5 B E BE

New  Quick New New

< Name | Australian Custome.

relationships | measure measure column  table

Structure Calendars. Relationships Calculations =
[ | X /|1 Austrelien Custoners Ssles - v| Fields N
2 SUMMARIZECOLUMNS ( l
= 3 | DimCustomer[CustomerKey]
a |, FILTER( P search
S VALUES(DimGeography [EnglishCountryRegionName])
ﬁg 6 » DimGeography[EnglishCountryRegionName] = "Australia") ~ B Australian Custo...
, "Customer Full Name", CONCATENATEX(DimCustomer, DimCustomer[FirstName] & " " &
DimCustomer[Lasthame]) ~ B DimCustomer
8 , "Sales Amount”, SUM(FactInternetSales[SalesAmount]) I |~ @ Dimbate
CustomerKey [~ | Customer Full Name [~] Sales Amount [~ « BB DimGeography
11093 | Aimee He 8180 ~ « BB DimProduct
11892 | Julio Ortega 811903
11895 | Dustin Chander 8149.04 v ] e rEe
11503 Kate Raji 810804 v E DimProductSubc..
12987  Felicia Moreno 6755.4696 B FactintenetSales
12988 | Barbara Goel 6915.4352
12859 Carly Goel 6817.1152
12950 Leslie Hernangez 6825.4656
CIRYS hd

Table: Australian Customers Sales (3,591 rows)

Figure 52: The results of running the preceding DAX expression

5.2.2 Calculated Columns

Calculated columns are the new columns created in the data model using DAX. There
are many scenarios when you want to create a calculated column; the general rule of

thumb is that you only create a new calculated column if:

e There’s a complex scenario and you want to create calculated columns to

use them in other calculations like measures.

* You need to create a new calculated column to be used in a slicer or as a filter

on a report element.

Other than that, you should avoid creating new calculated columns as there’s risk of

performance degradation.
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You can create a calculated column either from the Report view or the Data view (you
don’t need to complete this as a step):

A. Right click on a table from the Fields pane and select New Column.

B. Select a table from the Fields pane: select New Column from the Table
Tools tab.

C. Select a table from the Fields pane: select New Column from the
Modelling tab.

Figure 53 shows how to create a calculated column from the Report view.

Build visua

Select or drag fields from the

External Tools

2 A

,,,,,,,

5

REYF <
b= £
TM g
EF 3
= I

=py 9=

m®

g 2 [
AL
1/
o2)

<
9 2

=

Values
Select or dras
Add data

Figure 53: Create a Calculated Column

Let’s have a look at Calculated Columns in action. Follow the steps below:

1. Click the Data view tab from the left pane.
2. Go to the Fields column on the right, select DimCustomer.

3. Right click, go to New column. Type in the expression below.
4. Press enter.

Full Name = CONCATENATE(DimCustomer[FirstName] &“* DimCustomer[LastName])
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PowerBlintermediate - Power Bl Desktop

File Home  Help  ExtenalTocls  Tabletools  Column 4
= z

@ e [ = EEH
Mark as date Manage Quic New | New
1able v i table

structure Caendars J Caxy -

Full Neme = CONCATENATE(DimCustomer [Firstleme] & " ", DimCustomer[LostNane] v ;
w [ x v | T T ] ; Dl I~ Feids >

Fulllome |-
Latasha Suarez A | O search
550,000 Linda Rubio

530,000 Ketrina Sharma

AddressLine2 |~ | Phone =] DateFirstPurchase

500555-0150

00 555-0153
1(11) 500 555-0115
1(11) 500 555-0164 $30,000) Briarna Sanchez
1(11) 500 555-0153
1(11)500855-0195 Wednesdoy, 24 Juy
005550182 Mondoy, 16 Dece

530,000 Bridger Chande
$30,000] Shelby Bailey
530,000) Shawna Charder
530,000) Alexe Watson
$30,000) Jacquelyn Dominguez

v a lable 3
'NE DimCustomer

530,000 Kate Shan KELEELTE)
530,000] Colieen Lu AddressLine2
520,600 Temmy Sai 2 Annualincome
530,000 Lean L » [ BirthDate
$56 coiSHcTrers CommuteDistance

sananqgacees Co CustomerAlternat.
530.000) Alssa Lee

530,600 Jik Rubio

Customerkey

$20,000| Oiivia Price » B DateFrstpurch.

550,000| Nichole sharma Emallidiress

$30,000) Natasha sanz EnglishEducation
1(11) 5005550183 $30,000) Autumn Znu v EnglishOccupation

Figure 54: Creating Full Name calculated column in the DimCustomer table

Note that there’s a space between the “and” in the DAX expression!

5.2.3 Measures

Measures are normally analytical calculations: summations, calculating averages,
minimum, maximum, counts and so on. You can use the measures for visuals in Power
BI.

The result of the measures change depending on how we interact with them in different
visuals. For instance, you create a measure to calculate Sales Amount. If you put the
Sales Amount on a Card visual, it shows total sales amount over the whole data. If

you use the same measure in a Column Chart with Product Category on the Axis, the
measure always calculates the correct results for each category (Figure 55).

Sales Amount by
ProductCategoryName

Sales Amount by ProductCategoryName

| I
—
oot [

ProductCategoryName

Figure 55: The result changes depending on visual interactions

You can create measures in various ways, just like the way you create calculated
columns - either from the Report view or from the Data view (you don’t need to follow
these as steps).
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A. Right click on a table from the Fields pane and select New measure.

B. Select a table from the Fields pane and select New measure from the Table
Tools tab.

C. Select a table from the Fields pane and select New measure from the
Modelling tab.

File Home Insert Modeling View Help External Tools Table tools
& Name | FactintemetSales @
iate

~

ez [ A T

New column

New quick measure

External Tools Table tools

View

Insert Help

Home Modeling Refresh data s

p p A7|> A Edit query
Q4 AR / Incremental refresh
Manage View | Q&A Language Linguistic

s setup v schemav 4

ol Manage aggregations

Security Qsa k) Rename
Delete
. it
R - Hide
View hidden
Unhide all

Collapse all

Figure 56: Creating a new measure in Power Bl Desktop

Follow these steps below:

1. Click the Report view on the left pane.
2. Right click the FactinternetSales table in the Fields pane.
3. Click New Measure.

4. Use the DAX expression below. This creates a Sales Amount measure in the
FactinternetSales table.

Sales Amount = SUM(FactinternetSales[SalesAmount])

fle  Home Insert  Modeling View Help  ExternalTools  Table tools

e

D Na

R o

o )

® EMEME N

- M B e e
MELEOOH
QBB Aa~@
EEEBE-R
WEADE®
=

Y W WY S > Pt amiin

Figure 57: Creating Sales Amount measure in the FactinternetSales
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5. Click the Card visual from the Visualizations pane on the reporting

canvas.
6. Tick the Sales Amount
Card visual.

v B Sales Amount

measure to display its value on the

Figure 58: Showing Sales Amount on a Card visual

7. Click on a white space outside of the Card visual to release the focus from the

Card visual.

8. Go to FactIinternetSales and tick Sales Amount to add the measure to the

visual.

9. Click the Clustered Column Chart I visual from the Visualizations pane to

add on the report canvas.
10. Go to the Fields pane on the right.

11. Go to DimProductCategory and tick the ProductCategoryName column to

to the visual Axis.

File Home Insert  Modeling View Help  ExternalTools  Format ata / Drill
i GRERDEDR PR
e 2la o LOE o | & Lo
il Get  Excel PowerBl SQL Enter Recent Transform Refresh New lore N
< Format painter | dota datasets Serve data sources vl viswl box visuskiw! | mes

Cigbours o Queras

2936

fSales Amount by ProductCategoryName
30M

n B E

Sales Amount

oM —
Bikes Clothing

ProductCategoryName

Page1 Page2 |4

s A

E bl E

= & Mg

2 el E @ onowe

Q8 OWoa @ @ Onceogapy
EEDREER & onod
PE4on e Par——
o e
BT

EET 10
[ tegory’

Figure 59: Sales Amount by ProductCategoryName in a Clustered Column Chart
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Sometimes, creating analytical calculations is not as easy as a simple summation.

There are often other measures you have to create to satisfy the business
requirements; some requirements are complex. Power Bl makes lots of these
calculations super easy via Quick Measures - which you're about to discover more
about in the next section.

5.2.4 Quick Measures

You can use Power Bl to create complex reporting logics to analyse and visualise data.

Quick Measures are pre-defined calculations provided by Microsoft and can be
created on the fly. Let’'s have a look at some use cases.

Follow the steps to create a new measure on top of the existing Sales Amount
measure:

1. Go to the Fields pane, go to FactinternetSales, right click the Sales Amount
measure ¥ @ Sales Amou...
2. Click New quick measure.
3. Go to the Calculation dropdown list, go to Totals, select Running total.
4. The Sales Amount is already selected in the Base value.
5. Go to the DimDate table, drag and drop the Date column to the
Field section.
6. Click OK.

le tools Measure tools

Quick measures

Calculation Fields

Aunning total v

Visualizations 2 Fields

New messurs

=R E

i

THEABE

= KT8 9 5N
S HGCEE
P IMOREM

Rename

il & 510 & (% [

Delete
Hide
Add data fields here
View hidder
Drill through Unhide 3l
e Collapse all
Cross-report
off O—

Expand all

Add to fiters

Keep all filters

on—@

Figure 60: Creating Sales Amount running total in Date measure using Quick Measures feature
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You'll have a new measure named ‘Sales Amount running total in Date.’

7. Select the Line Chart visual from the Visualizations pane.

8. Go to the Fields Pane, select FactinternetSales, tick the Sales Amount
running total in Date measure to put it in the chart’s Values.

9. Go to DimDate, tick the Date column.
10. Right click on the Date from the Axis field.

11. Click Date to show the Date column as normal date (not a date hierarchy).

Y Filters @ > Visualizations > Fields >

£ search B EbE M osean
2

Filters on this visual Bl v EB Australian Custo..

1 Date ~ B DimCustomer

is (Al PY E @ DimDate
H Sales Amount running t... O CalendarQu...
3 |
£ is (All) O CalendarSe...
s M Adis O  CalendarYear
g Add data fields here > o
15 1 Date v X S
= O  DateKey
g Filters on this page .+ Legend O  Dayl 0...
<
H Al data s Add data fields here O DayNumbe..
o a2 fielos here O  DayNumbe...
o Values
2011 2012 2013 2014 O  DayNumbe...
L Dt 4 Filters on all pages £ AT D O FiscalQuarter
Second ) O  FiscalSemes...
econdary values
Add data fields here O FiscalYear
Add data fields here
O MonthName
Tooltips O MonthNum...
Add data fields here O WeekNumb..

Figure 61: Visualising Sales Amount running total in Date

There’s a long list of available quick measures; lots of them useful. You can also learn
how to write DAX using quick measures. For instance, you can click the Sales Amount

running total in Date measure and look at the formula bar to learn how to write a

running total over date as Figure 62 shows:

File Home Insert Modeling View Help External Tools Table tools Measure tools

=
- New  Quick
Home table | FactinternetSal v v % 9% Aut
(n) Home table | FactlnternetSales $% 9% Ao D meseure messure

Structure Formatting Properties Calculations o
ml = X ~/ |1 Sales Amount running total in Date = v W "
) caLcuLared | Visualizations > Fields >
3 [Sales Amount],
= 4 FILTER( E b E E A L search
E] 5 ALLSELECTED( 'DimDate’ [Date]), A M BE e 2
88 ] 6 ISONORAFTER('DimDate’ [Date], MAX('DimDate’[Date]), DESC) MFLEOH ()= PromotionKey
2 7
s ) T QBT AaE O X RevisionNumber
E] BFE B R [JB_Sales Amount
PYE = 0Z @ l BE Sales Amount running total in Date '
TS SolesAmount
2 DX SalesOrderLineNumber
O SalesOrderN r
O s T P A ol B e i VS ’_, ~~ 7r"f VY |

Figure 62: Click on a quick measure to learn how the corresponding DAX is written
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5.2.5 Time Intelligence

Time intelligence provides measures that simplify complex time-based reporting.

For example, time-based calculations for Year-to-Date (YTD), Month-to-Date (MTD),
and Previous Period comparisons. In this section, you'll learn:

¢ What time intelligence means in the data level.
e Which time intelligence functions are available in DAX .
* How to overcome complex time intelligence challenges using Quick Measures.

If you're unfamiliar with time intelligence, it's about time-based calculations.

For instance, when you calculate a Year-to-Date (YTD) metric, you're summing the
values of that metric on a daily basis, starting from 1st Jan of each year up until the

provided date. When you calculate a Month-to-Date (MTD) metric, you're summing the

values of that metric for each day, starting from the 1st day of the month up until the
provided date.

Let's have a look at an example.

Figure 63 shows Sales Amount values side-by-side to Sales Amount MTD and Sales
Amount YTD :

Date Sales Amount  Sales Amount MTD  Sales Amount YTD

1st Jan _ 1/01/2011 7.156.54 7,156.54 7,156.54

—/ 2/01/2011 15,012.18 22,168.72 22,168.72

3/01/2011 14,313.08 36,481.80 36,481.80

4/01/2011 7,855.64 44,337.44 44,337.44

5/01/2011 7,855.64 52,193.07 52,193.07

6/01/2011 20,909.78 73,102.85 73,102.85

7/01/2011 10,556.53 83,659.38 83,659.38

8/01/2011 14,313.08 97,972.46 97,972.46

9/01/2011 14,134.80 112,107.26 112,107.26

10/01/2011 7,156.54 119,263.80 119,263.80

11/01/2011 25,047.89 144,311.69 144,311.69

12/01/2011 11,230.63 155,542.32 155,542.32

13/01/2011 14,313.08 169,855.40 169,855.40

14/01/2011 14,134.80 183,990.20 183,990.20

15/01/2011 6,953.26 190,943.46 190,943.46

16/01/2011 25,568.71 216,512.17 216,512.17

17/01/2011 11,255.63 227,767.80 227,767.80

18/01/2011 14,313.08 242,080.88 242,080.88

19/01/2011 38,241.29 280,322.17 280,322.17

20/01/2011 15,012.18 295,334.35 295,334.35

21/01/2011 10,734.81 306,069.16 306,069.16

22/01/2011 11,433.91 317,503.07 317,503.07

23/01/2011 17,534.79 335,037.86 335,037.86

24/01/2011 28,041.32 363,079.18 363,079.18

25/01/2011 19,785.36 382,864.54 382,864.54

26/01/2011 17,688.07 400,552.61 400,552.61

27/01/2011 14,402.34 414,954.95 414,954.95

28/01/2011 15,012.18 429,967.13 429,967.13

29/01/2011 17,891.35 447,858.48 447,858.48

30/01/2011 10,734.81 458,593.29 458,593.29

31/01/2011 11,230.63 469,823.91 469,823.91

MTD Value Resets 1/02/2011 17,534.79 17,534.79 487,358.70
———— 2/02/2011 15,711.28 33,246.07 503,069.98 ———

Total 29,362,255.49 45,694.72

Figure 63: Sales Amount MTD and Sales Amount YTD

Look at the first and last 3 rows of Figure 64 to see how the numbers are calculated.
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Cumulative;SumjofiSales
Amountiofithe 2firstirows

Date Sales Amo

1012011 || 7.156.54
2/01/2011 15,012.18

3/01/2011 14,313.08

Cumulative;Sum,ofiSales
Amount;ofithe;3 firstirows

Date Sales Amount ~ Sales Amount MTD  Sales Amount YTD

30/12/2011 3,964.99 641,031.50 7,047,125.93

31/12/2011 28,400.00 669,431.50 7,075,525.93
1/01/2012 16,331.01 #6,331.01 16,31.01

4

Cumulative Sum of Sales
Amount of all days in 2011

Figure 64: The math behind Month to Date and Year to Date calculations

You might think that the underlying calculation is complex.

The good news is that there are specific functions in DAX that take care of the
complexities around the logics. This is shown below.

Sales Amount MTD =
TOTALMTD([Sales Amount],‘DimDate’[Date])

Sales Amount YTD =
TOTALYTD([Sales Amount], ‘DimDate’[Date])

We used TOTALMTD() or TOTALYTD() DAX functions to create the above measures.
We used the (already created) Sales Amount measure in those functions along with
the Date column from the DimDate table. The DimDate is a Date table holding date
related data. The Date table is the basis for all time intelligence functions available in
Power BI, therefore we need to have a Date table in our model.

What if our data source doesn’t have a Date table? We have two options:

A. Use the Auto DateTime feature in Power Bl Desktop
B. Generate a Date table

Let’'s look at the Date table in more detail and see why we need one in our data model.
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5.2.5.1 Why a Date Table is needed in Power Bl

The Date table is the basis for time intelligence functions to work correctly, but
there’s another reason why we need to have a Date table in a Power Bl model.

The Date table provides the detail for a date. If you go to the Data view (make sure
you have selected FactinternetSales on the right pane outlined in red in Figure 65),
you'll see 3 date columns: OrderDate, ShipDate and DueDate columns. While those
columns provide date values and we can use them to analyse our data, what if we
need to analyse by other date elements? e.g. Sales Amount by month to see our
bestselling month.

You can achieve this by creating a calculated column to show Month values.

What if you want to analyse the Sales Amount by financial year, do you create a
calculated column? Business queries can grow over time; it's unwise to create new
columns whenever the business asks new questions. Look at Figure 65. There are
60,399 rows of data.

W X Fields >
| ProductKey |~ | OrderDateKey |~ | DueDateKey |~ | ShipDateKey |~ | CustomerKey |~ | Promotionk
E 528 20130128 20130209 20130204 14870 x p Search
ﬂg 528 20130129 20130210 20130205 15319
528 20130131 20130212 20130207 16384 v B Calculated Table 3
528 20130131 20130212 20130207 15476 « B DimCustomer
528 20130201 20130213 20130208 15861
v B DimDate
528 20130203 20130215 20130210 26017
528 20130203 20130215 20130210 14761 ~ BB DimGeography
528 20130204 20130216 20130211 22038 « B DimProduct
. " 13, " 1
528 20130204 20130216 20130211 22163 v B DimProductCateg.
528 20130204 20130216 20130211 16018
DimProductSubc...

528 20130205 20130217 20130212 25839 v B

<
| TABLE: FactintenetSales (60,399 rows) |

Figure 65: Number of rows of the FactInternetSales table in the Data view

Creating a new column to only add the Month values increases the size of the
FactinternetSales table, i.e. it unnecessarily increases the size of the report file and
leads to poor performance in larger reports.

To overcome this challenge, create a separate Date table by adding as many
columns as you need, then create relationships to other tables to analyse their
data over date elements. Figure 66 shows the data in DimDate from the sample
file supplied with this guide. DimDate only has 3,652 rows, but it provides rich and
detailed date elements for data analysis.

Figure 66: DimDate of the sample file
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5.2.5.2 Auto Date/Time Feature in Power Bl

If you don’t have a Date table in your data source, don’t worry. You can enable the
Auto date/time feature in Power Bl Desktop. Power Bl automatically takes care of the
Date table. To enable this feature, follow the steps:

1. In Power Bl Desktop click the File menu
2. Click Options and settings
3. Click Options

Insert  Modeling  View Help  External Tools
[ T o FF rﬂ
bish
. . 2
Options and settings
lizations > Fields >
3 EWMEB | 5 s
MO L e
[B et souce setings E @ OB W AsiinCoromen s
I8 A& E V@ Colulbted Toble 1
I BEE R @ coustedmvie?
A0 BE® B Calculsted Table 3
~ @@ DimCustomer
? @ A E DimDate
“ & Date
( DateKey
nount v x O o
nount MTD /X [ Dny Name

Figure 67: Opening Power Bl Desktop Options

4. Under the GLOBAL section, go to the Data Load tab. Under Time
intelligence - tick Auto date/time for new files (This may be already ticked).

This enables the feature globally across all Power Bl files you create in future.

Power Query Editor
DirectQuery

R scripting

Python scripting
Security

Privacy

Data Load
Regional Settings
Privacy

Auto recovery

X
Options
GLOBAL R Type Detection
Data Load O Always detect column types and headers for unstructured sources

v

® Detect column types and headers for unstructured sources according to each
file's setting

O Never detect column types and headers for unstructured sources

Time intelligence
rv Auto date/time for new files O Learn more

Data Cache Management Options ©

Maximum allowed (MB): | 4096 (0]

oK Cancel |

Figure 68: Enabling Auto date/time globally
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5. Under the CURRENT FILE, tick Auto date/time.
6. Click OK.

X

Options
GLOBAL A Type Detection

Data Load ¥ Detect column types and headers for unstructured sources

Power Query Editor Relationships

DirectQuery ¥ Import relationships from data sources on first load O

R scripting [ Update or delete relationships when refreshing data O

Python scripting ¥ Autodetect new relationships after data is loaded (O

Security Learn more

Privacy

Time intelligence

Regional Settings
Updates [' Auto date/time (O Learn more e

Usage Data Background Data
Diagnostics ¥ Allow data preview to download in the background
Preview features Parallel loading of tables
Auto recovery ¥ Enable parallel loading of tables @
Report settings
’ Q&A
CURRENT FILE ¥ Turn on Q&aA to ask natural language questions about your data O
Regional Settings
Privacy
Auto recovery v 6

E -

Figure 69: Enabling Auto date/time for the current file

After enabling the Auto date/time feature, you'll see that all Date or DateTime type
columns have changed to Date Hierarchy (Figure 70).

Fields >

P search

~ [, FactinternetSales

O  CarrierTrackingNumber
AR i, i

(1> DiscountAmo
= DueDateKey
O ExtendedAmount
0= Freight Expanded

A~ OB OrderDate Hierarchy

A D% Date Hierarchy
OB Year
O Quarter
O Month
O Day
O OrderDateKey

Lo AR et
(m] !alesOrderHumber

(1% SaleTezitorey

O& ShipDate

Figure 70: Enabling Auto date/time automatically creates date hierarchies for date columns
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Now that you’'ve enabled the Auto date/time feature, you can use Quick Measures
to build time intelligence measures - without having (or creating) a Date table in the
model.

It's advised to create a Date table if your source system doesn’t have one,
rather than relying on the Auto date/time feature. While the Auto date/time
feature can be very helpful, it comes with some side effects. If you enable the
Auto date/time feature, Power Bl Desktop creates private Date tables in the
background. Indeed, Power Bl creates a Date table per column with either
Date or DateTime data type regardless of whether we need to analyse them
or not.

Not only is it excessive to have a Date table per column, but it can cause

serious performance and storage issues. To disable this feature, just reverse
back the settings we made in this section.

5.2.5.3 Generating a Date Table in Power Bl Desktop

There are two ways to create a Date table in Power Bl Desktop:

1. Create a Date table in Power Query (M) language.
2. Create a Date table using DAX.

Note: Our sample file already has a Date table (DimDate), so we don’t need to
generate another Date table. However, we include two extra Date tables just for the
purpose of this guide - helping you solving real-world challenges.

5.2.5.3.1 Generating Date Table in Power Query

Open the Power Query Editor and go through the steps below to generate a Date
table using Power Query (M) language. Follow these steps:

1. Open Power Query Editor (go to Transform Data).
2. Click New Source (or Get Data) dropdown button.
3. Click Blank Query.

SQL Server

Analysis Services
Figure 71: Opening a Blank Query in Power
Query Editor 2 e

== ODatafeed

[L‘ Blank Query
= s
More...
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4. Click the Advanced Editor button from the Home tab.
5. Copy the scripts below and paste in the Advanced Editor window.
6. Click Done.

let

Source = List.Dates(#date(2010, 1, 1), Duration.Days(Duration.From(#date(2014, 12, 31) -
#date(2010, 1, 1))), #duration(1, 0, 0, 0) ),

#"Converted to Table” = Table.FromList(Source, Splitter.SplitByNothing(), null, null, ExtraValues.
Error),

#"Renamed Columns” = Table.RenameColumns(#“Converted to Table”{{"Column1’, “Date"}}),

#"Added Custom” = Table.AddColumn(#”"Renamed Columns’, “DateKey", each Text.
Combine({Date.ToText([Date], “yyyy”), Date.ToText([Date], “MM”), Date.ToText([Date], “dd")})),

#"Changed Type” = Table.TransformColumnTypes(#"Added Custom’,{{"Date’, type date},
{“DateKey”, Int64.Type}}),

#"Year Column Added” = Table.AddColumn(#"Changed Type”, “Year”, each Date.Year([Date])),

#"Quarter Column Added” = Table.AddColumn(#"Year Column Added”, “Quarter”, each “Qtr
“&Text.From(Date.QuarterOfYear([Datel))),

#"MonthOrder Column Added” = Table.AddColumn(#"Quarter Column Added”,“MonthOrder”,
each Date.ToText([Date], “MM")),

#"Short Month Column Added” = Table.AddColumn(#”MonthOrder Column Added”, “Month
Short” each Date.ToText([Date], " MMM")),

#"Month Column Added” =Table.AddColumn(#”Short Month Column Added”, “Month”, each
Date.MonthName([Date])),

#"Changed Columns Type” = Table.TransformColumnTypes(#”Month Column Added"{{“Year",
Int64.Type}, {“MonthOrder”, Int64.Type}})
in

#"Changed Columns Type”

The script generates dates between 2010 to 2014 (our sample data only covers
that date range).

This is most probably different in your real-world scenarios; therefore, you need to
change the code to satisfy your needs. To cover a different date range, you need
to change those numbers in the code.

a Display Options ~ @
) 0, 8,0 ),

il
({Date.ToText([Date], "yyyy"
! ey”, Int64.Type}}),

#"Changed Co: er”, Int64.Type}})

#"Changed Columns Type"

/ No syntax errors have been detected. 4
[E] e

Figure 72: Generating Date table in Power Query
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Queries [8]

B
o]
o]
B
[z
|
B

6. Rename the Query1 query to Date with M

7. Close and Apply to exit Power Query

DimCustomer

DimDate

DimGeography

DimProduct

DimProductCategory

DimProductSubcategory

FactinternetSales

6

7 COLUMNS, 999+ ROWS  Column profiling based on top 1000 rows

Jx || = Table.TransformColumnTypes(#"Month Column Added”,{{"Vear", Int64.Type}, v
2. =] pate ~ 123 Datekey ~] 123 Year ~] 455 Quarter
I!!u u|>x|l(|||\|n|0|0|ulv|q|u!| || ||!ﬂ|()|!!lllc|I|\|ﬂ|lll)|\J|v|QI1E || !lulmm 0 unique
1 1/01/2010 20100101 2010 arr1
2 2/01/2010 20100102 2010 atr1 o)
3 3/01/2010 20100103 2010 atr1
4 4/01/2010 20100104 2010 atr1
5 5/01/2010 20100105 2010 Qtr1
6 6/01/2010 20100106 2010 Qer1
7 7/01/2010 20100107 2010 arr1
8 8/01/2010 20100108 2010 Qur1
9 9/01/2010 20100109 2010 aer1
10 10/01/2010 20100110 2010 arr1
n 11/01/2010 20100111 2010 arr1
12 12/01/2010 20100112 2010 atr1
13 13/01/2010 20100113 2010 atr1 %

Figure 73: Date table in Power Query

Query Settings X

4 PROPERTIES
Name
Date with M

All Properties

4 APPLIED STEPS
Source
Converted to Table
Renamed Columns
Added Custom
Changed Type
Year Column Added
Quarter Column Added
MonthOrder Column Added
Short Month Column Added
Month Column Added

X Changed Columns Type

PREVIEW DOWNLOADED AT 5:13 PM

5.2.5.3.1 Generating Date Table using DAX

The second method to create a Date table is using DAX by creating a new

calculated table (as per 6.4.1).

The DAX code generates the same Date table as the one we created with Power

Query:

Date with DAX =
ADDCOLUMNS(CALENDAR(DATE(2007,1,1), DATE(2020,12,31))

,“DateKey”, VALUE(FORMAT([Date], “YYYYMMDD"))

,“Month’, FORMAT([Date], "MMMM”)
,“Month Short", FORMAT([Date], “MMM”)
,“MonthOrder’, FORMAT([Date], “MM”)

,“Quarter’, CONCATENATE(“Qtr “, QUARTER([Date]))

,“Year”, YEAR([Date])

The result of the DAX formula is shown in Figure 74.

X vt

2

3

a

5

8

9
Date ~
1/07/2012 12:00:00 AM

2/07/2012 12:00:00 AM
3/07/2012 12:00:00 AM
4/07/2012 12:00:00 AM
5/07/2012 12:00:00 AM
6/07/2012 12:00:00 AM
7/07/2012 12:00:00 AM.
8/07/2012 12:00:00 AM
9/07/2012 12:00:00 AM
10/07/2012 12:00:00 AM
11/07/2012 12:00:00 AM
12/07/2012 12:00:00 AM
13/07/2012 12:00:00 AM
14/07/2012 12:00:00 AM
15/07/2012 12:00:00 AM

Date with DAX
ADDCOLUMNS]

DateKey [~ Month [~ | Month Short [~

20120701 July
20120702 July
20120703 July
20120704 July
20120705 | July
20120706 | July
20120707 July
20120708  July
20120709 July
20120710  July
20120711 July
20120712 July
20120713 July
20120714 July
20120715 | July

ENDAR(DATE(2010,1,1), DATE(2014,12,31))
", VALUE(FORMAT([Date], "YYYYMHDD"))

ICATENATE("Qtr ", QUARTER([Date]))

Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul
Jul

Jul

, "Year", YEAR([Date])

07 Qw3
07 a3
07 a3
07 a3
07 Qw3
07 Qw3
07 a3
07 a3
07 a3
07 Qw3
07 Qw3
07 a3
07 ar3
07 Qw3
07 Qw3

MonthOrder [~ | Qyarter [~] Year [~

2012
2012
2012
2012
2012
2012
2012
2012
2012
2012
2012
2012
2012
2012
2012

v

Fields >
£ search

v B Australian Customers Sales
v B Celculated Table 1
v B Calculated Table 2
v B Celculated Table 3
A BB Date with DAX
» B Date
= DateKey
Month
Month Short
MonthOrder
Qarter
= Year
v @ Datewith M
~ B DimCustomer
“ @ DimDate

~ B DimGeography

R gt 2503 g lannns Rt B st [ BN i o i gk

Figure 74: Generating Date table using DAX
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5.2.5.4 Marking Date Table as Date

So far you've learnt: what a Date table is, why you need one in the Power Bl model,
how to generate one if the Date table doesn'’t exist in the source system. You ‘ve also
learnt how to configure and use the Auto date/time feature in Power Bl Desktop.

But having a Date table in your data model doesn’t mean that the time intelligence
functions will work correctly. Your Date table must meet requirements below:

¢ Your Date table MUST have one column with Date data type
* The Date column MUST contain unique values

* The Date column MUST have continuous date values - without any gaps in
the dates

e The Date column values MUST start from 1st Jan of a starting year; going
upto the 31st Dec of an ending year

e Mark the Date table as Date

The first 4 requirements are the prerequisites for the 5th requirement.
Here's how to ‘Mark as Date’.

Right click the Date table you would like to mark as Date.
Hover-over Mark as date table.

Click Mark as date table.

Select a Date column from the dropdown list.

Click OK.

ok L=

Figure 75: Marking Date table as Date
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5.2.5.5 Adding Time Intelligence Quick Measures

Quick Measures are pre-defined calculations.

In the following steps, you'll create Year-to-Date measures over the OrderQuantity

column; from the FactinternetSales table using Quick Measures. Follow these steps:

. When in Power Bl Desktop, expand FactinternetSales.

. Right click the OrderQuantity column.

. Select New quick measure from the context menu.

. Select Year-to-date total from the Calculation dropdown.
. Make sure Base value is Sum of OrderQuantity.

. Expand the DimDate table.

. Drag Date to the Date box.

. Click OK.

O N O O B~ WN =

These steps are shown in Figure 76.

gr==zs
L---i@-‘-___l

Figure 76: Creating a new time intelligence with Quick Measures feature

Power Bl Desktop adds your new measure to the Fields pane and displays the
generated DAX code (Figure 77).

The DAX code is fully functional and requires no further changing. It’s strongly

advised that only qualified Bl technicians edit or create DAX code for business-
critical systems.
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X « [ Orderquantity YD = v Fields N
2 TOTALYTD(SUM('FactInternetSales'[OrderQuantity]), 'DimDate'[Date])' r

A search

v B DimProductSubcategory

s A

~~ B FactinternetSales

[0 CarrierTrackingNumber

J  OrderDate
) OrderDateKey
[J = OrderQuant

B OrderQuantity YTD

= Pradiirtkay

Figure 77: The new measure created by Quick Measures feature

6. Reporting on the Data -
Creating Visualisations

In the previous chapter we learnt:

* How to prepare data in Power Query

¢ | oad resulting data into the data model

e Creating calculated tables, calculated columns and measures
e Creating and configuring the Date table.

Now, it's time to visualise the data in Power Bl Desktop.

6.1 Building Basic Visualisations

Let’s start with a graph to support a simple business scenario.

SCENARIO: Follow these steps:

Our Sales Manager wants to track the value of website bike sales over the last few years.
1. From the Report view, select the Stacked Column Chart visual from the

Visualizations pane (This will add a grey “place holder” graphic to the Report
Canvas).
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Figure 78: Adding a Stacked Column Chart to the report canvas

2. Drag the Sales Amount ¥ B salesamount  megsure, drop it on the visual place
holder (this creates one column).

-ulations ~
FEales Amount
Visualization: Fields >
< B E Illﬂ =
o PO M B e
h FMFLEQOM .
. ey} azeias o\
i U EEREER
WE D E® i W
uctStanda.
tionKey
‘:ﬂz, @ [l RevigonNumbe

v e Add data fields here Sales Amountr...

N - *'I,“ N B): SgesAmount o,

Figure 79: Drag and drop the Sales Amount measure to the visual

3. Drag the CalanderYear column from the DimDate table and drop it on the visual
(this adds the Year to the visual's Axis).

e s [ anuiaus

Y Filters @ > Visualizations > Fields >
O search B E = O search
Filters on this visual . lﬂ] g E O @ v BB Australian Custo...
— L
&2 Calendarear ¥ a “ BB Date with DAX
Bales Amount by CalendarYear 1 h p
20m is (All) EEERPMNME o BB Date with M
Sales Amount BE D E‘ ® ~ B DimCustomer
15M is (Al T @ A [ DimDate
H Axis
E Add data fields here UZ CalendarQu.
[ CalendarYear v X X CalendarSe...
;: ¥ 3 CalendarYear
Filters on this page Legend K= Date
Add data fields here
. Add data fields here O EEEgy
Values O DayNameO...
e = o ® O X DayNumbe...
CalendarYear Sales Amount v X
Filters on all pages OX DayNumbe
i 3 DayNumbe...
Add data fields here ot o ayfiumbe
Add data fields here L= FiscalQuarter
0= FiscalSemes...

Figure 80: Drag and drop Year to the visual
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4. Click the chart, go to the the Visualizations pane, click the format icon from the

visualizations pane.
5. Disable Y Axis.

6. Enable Data Labels to show values on each bar. This makes the visual more

readable.

IBales Amount by Year - -

__
Sales Amount

i
|
;

S

siPld A

Visualizations >

O search
v General
v X axis On —@
Vv Y axis "
v Data colors

v Data labels

~ Plot area

v Title

Figure 81: Disabling Y Axis and enabling Data Labels of the Stacked Column Chart

Next, our marketing manager would like to know the occupation of customers who order

the most stock to target with a new campaign.

We'll follow a slightly different approach to build this visualisation:

7. Drag the OrderQuantity column from the FactinternetSales and drop it onto a
blank space of the report canvas. This creates a new Visualisation using the

default Stacked Column Chart.
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Sales Amount by Year

iz}
& .
§ = Cvcc@u"t ty

Visualizations > Fields >

E

L search

O CarrierTracking...
OZ Currencykey
) CustomerKey
O CustomerPON..
O X DiscountAmount
v OB DueDate
()X DueDatekey
O X ExtendedAmou..

s A

Values

Add data fields here

X Freight
Drill through ~ O OrderDate
e oo 0 __OrderDatek
) Z OrderQuantity
Off O—
ProductKey
Keep all filters O ProductStanda..

T N, P oon P ot P el 0 s B L NP T Rl

Figure 82: Creating new visual on the report canvas by dragging and dropping a column to a blank space

8. Drag the EnglishOccupation column from the DimCustomer and drop it on the
newly created chart.

< Visualizations > Fields >

EHMEREB o san

4 A

~ BB Date with DAX

BEERK

fOrderQuantity by EnglishOccupe 717 .1

20¢

B
(CRC]
A &

~ BB DatewithM
E g ; A B, DimCustomer

O AddressLinel

* o O Addressline2
1 &) = Annualincome
i l BirthDate
. EnglishOccupation X O WemmuteDistance
. . o
g

O  CdomerAltemate..
Legend O Cushmerkey

Add data fields here O DetelistPurchase
(m]

EnglishOccupation 4

r

B ot £ A0 A auh e
OrderQuantity
sia4
SHeER

Values

[ __engideduction
OrderQuantity v x
Small multiples = T
Add data fields here O Full Name

O Gender
Tooltips.

' O  GeographyKey

Add data fields here OF Howcomaig

W“M‘u

|

Figure 83: Continue adding columns to visuals by drag and drop

9. Make sure the column chart is still on focus, then click on Pie Chart visual from the
Visualizations pane to turn the column chart to a Pie chart.

— —
Sates Amount by Year OrderGuantty by EngushOccupation ¢
] < Visualizations > |
4
B - < b
o n il 2 o
g S %
) &
B . ) e P
H
i {
i Vaues {
Add cata felds here {
Drill through /
Crossreport
oro— {
-
Keep all filters ’
. ] on—@ P
Yar
Add drilthrough felds here | €

- L oW [ AR SV P Y

Figure 84: Converting Column chart to Pie chart
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10. Move and resize the visuals to nicely fit the page.

Salz Amount oy vear m Orderduantiy by ccupation
. oxapsion
H peiv
h . I ‘ e

Figure 85: Adjusted visuals to fit the page

Now that you've learnt various ways of creating visuals, let’s have a look at visualisation
interactivity.

6.2 Visualisation Interactivity

With multiple visualisations visible on a page, Power Bl Desktop allows you to cross-
highlight and cross-filter the data between visualisations. You would do this to further drill
down into your data.

Let's see how the visuals interact with each other. Click on the Professional slice on the
Pie chart to see sales distributed across all years for this occupation. Follow these steps:

1. In the Report Design view, click on the Professional slice of the Pie Chart.

2. The portion of InternetSales related to Professionals is highlighted on the Stacked
Column Chart and Pie Chart - this will cross highlight the other charts on the report

page.

Sales Amount by Year r OrderQuantity by Occupation <7 2 ..

saM
11K (754%)
22M
1M
oo - - oo
2010 2011 2012 2013 2014
Year v

Figure 86: Cross-highlighting in visual interactions in Power Bl Desktop
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3. You can edit the cross-highlighting behavior to cross-filtering:
A. Select the Pie chart from the report canvas
B. Go to the Format tab, click the Edit interactions
C. Change the interactivity of the Column chart to Filter.
D. Select the Column chart
E. Change the interactivity of the Pie chart to Filter (Figure 87)

File ~ Home Insert  Modeling  View Help  ExtenalTools  Format  Data/Drill

D erenomeense | B Y & B [H

Edit Bing  Send  Selection Align

interaction: forward backward fiter
Sales Amount by Year r OrderQuantity by Occupation 7 & e

= :
&3 e
2
g
< I
]
Year " _ |
File Home Insert Modeling View Help External Tools Format Data / Drill
B} Apply drill down fiters to ] ‘P:: I}
7 th G e |
Edit | Bring  Send  Selection Align ¢
interactions forward rd v Fiter
- r Sales Amount by Year T B OrderQuantity by Occupation ﬂm P
il »
= o
<3 2
e
H
12 1
a
L i Year ) ';

Figure 87: Editing visuals interactions

4. Click the Edit Interaction button again to set the changes.

©theta | Power Bl for Intermediates

>

suoneziensin A
splLy

suoneziensin A~
splald



You can change the default interaction behavior from cross-highlighting to cross-filtering
by following the steps below:

1. File

* Options and settings

e Options

2. In the Options window, click Report settings tab (under the Current File).

3. Tick the Change default visual interaction from cross highlighting to cross
filtering.

4. Click OK.

e Insert  Modeling  View  Help  ExternalTools  Format  Data / Drill

Options
Options and settings

I Don't allow end user to save filters on this file in the Power Bl senvice

¥ Use the

el« Change

Export data

Filtering experience

¥ Allow users to change filter types

¥ Enable =

in this report to use drillthrough targets from other reports

Personalize visuals (preview) 6

Figure 88: Changing the default visual interaction setting

7. Custom Visuals in Power Bl

Power Bl has a rich selection of visuals that can be used in your reports. You can also get
Custom Visuals from AppSource.

7.1 Getting Custom Visuals from AppSource

Click the ... button on the Visualizations pane.
Click Get more visuals.

Search to find the custom visual you are after.
Click Add.

o~

©theta | Power Bl for Intermediates 63



Power Bl Visuals

AppSource My organization
Add-ins may access personal and document information. By using an add-in, you agree to its Permissions, License Terms and Privacy Polic
Category
All Abard provide
A ced A lytic: L B
su n Restore default visuals z

vrin mrougn

YVord Cloud #% ) Add VE

P Create a fun visual from frequent text in your data Cross-report
: ok k off v E

Gauges v E
Infographics Keep all filters vE
Pls [nfographlc DeS|gn§r % A Add on—@

Beautify your reports with easy-to-create infographics
Maps IIH EE *kkk Add drill-through fields here

Power BI Certified

Time R,
Y\5|o Visual #% Aaa
Bring y o life in ways that only
Microsoft \ sualize v

Figure 89: Getting custom visuals from AppSource

Custom Visuals are created by third parties, so they are NOT available within the
Power Bl Desktop by default. Just because they’re on AppSource, it doesn’t mean
they're all safe to use. We'd recommend only using those which are Certified by
Microsoft: they are fully tested and recognised as a safe visual. The custom visuals
that are certified come with a Certified badge. %

The custom visual appears in a separate section beneath the default visuals in the
Visualizations pane (Figure 90).

AV

<  Visualizations

i
=
M

i) A
‘Mo EX
M| dl 2

|

an 51 T IE

THA»CEE
KNE D> CREM
g ~EEKE

:t Chart 2.0.1

Figure 90: Custom Visuals show in a separate space underneath the default visuals in the Visualizations pane
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7.2 Removing a Custom Visual

To remove a custom visual, follow the steps below:

1. Click ... from the Visualizations pane.
2. Click Remove a visual.

3. Select the custom visual you want to remove. You can also select multiple custom
visuals - Ctrl + select the custom visuals you want to remove.

4. Click the Remove button.

" < Visualizations >
EkE E A
Select visuals to remove X B oMW
MFLELO0OH
These visuals were imported from a file or from AppSource. Removing them QBT A
here will remove all instances of the visual from the current report. If a = - E E R
removed visual is not pinned to the visualizations pane, to use it again in the E
future, you'll need to import it. 1 E =f ] E‘ o)
) == Bullet Chart 2.0.1 associated tiles: 0 ]‘- - ‘9 Get more visuals
w  WordCloud 2.0.0 asscciated tiles: 0 Import a visual from a file
ll Remove a visual 2
. Infographic Designer 1.8.9 associated tiles: 0 |
| Restore default visuals
AQQ cata nielas nere
4 Drill through
X Cross-report
Number of visuals selected : 2 @]
h off O—

{ Keep all filters

Figure 91: Removing Custom Visuals from Power Bl Desktop

8. Publishing to Power Bl Service

After you've finished your data visualisations in Power Bl Desktop, it’s time to Publish the

report to Power Bl Service.

If you have permission to publish reports to the service, it's easy. If you don’t have

access/permission, you won't be able to publish and share your reports in the cloud. You
can still use your reports in Power Bl Desktop or share it with others by sending them the

.pbix file.

Follow the steps below to publish your report to Power Bl Service (Figure 92)
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1. Click the Publish button from the ribbon bar.

2. Type in you Power Bl Service credentials.

3. Click Sign in.

4. Select a workspace you want to publish your report to.

5. Click Select.

6. After your report is successfully published, you can click the report link on the

Publishing to Power Bl window.

Publishing to Power BI

V/ Success!

7. Click Got it.
il Home  Insert  Modeling  View  Help  External Tools
Cipbour
7] < > Fields
= o CEHMEMEN O s
- Signin o M ke
g M T @O HE vE AustalanCusto.
C QPP AARMDE vE CalulatedTable 1
Power Bl Desktop and the Power Bl service work seamlessly = B R
when youfre signed in. E ; E E g D st
e B Glaibied T 3
X
[ Enter Your Power BI Service Account ] Publish to Power Bl
3 Select a destination
Need a Power Bl account? Try for free ~
v

Open +.pbix’ in Power B
& ) ]e

Get Quick Insights

aly Didyou know?
You can create a portrait view
On the View tab, select Mobile Layout. {ear moré

of your report, tailored for

mabile phages.

7

Figure 92: Publishing report from Power Bl Desktop to Power Bl Service

9. Conclusion

In this guide, you'’ve learnt how to import data from multiple Excel files and join related

data to build up a meaningful data model that you can use to visualise and interact with.

By using the Quick Measures feature, you've been able to extend measures with time
intelligence; enhancing analysis without writing any code and to provide meaningful

insights.

You also know how to get custom visuals and how to remove those that are not necessary

anymore.

We hope you enjoyed the guide.

If you need some formal training, you can find out more about our training courses or

email us enquiries@theta.co.nz.
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11. Glossary

Data transformation — converting data from one format/structure to another format/
structure

Visualise — graphical representation of data

Shaping/shape — also known as wrangling or manipulation. The process of transforming
and mapping data from one “raw” data form into another format so that it is more
appropriate/valuable for analytical purposes

Power Query Editor — a dedicated window that facilitates and displays your data
connections and transformations you apply

Report Canvas - a blank canvas area where visualisations are placed

One-to-Many — a type of cardinality that refers to the relationship between two entities A
and B in which an element of A may be linked to many elements of B, but a member of B
is linked to only one element of A. For instance, think of A as product, and B as sales

Auto detected — when loading data from different sources, Power Bl Desktop will
automatically detect or create relationships between two or more tables

Quick measures - lets you quickly create new measures (calculations) without coding
based on measures and numerical columns in your table

Dimension — descriptive data that adds context to transactional (fact) data e.g. year/
month/date, location, customer and product. They are in the filters/columns/rows field.

Fact — transactional data that is generally aggregated in report visuals, €.g. sum of
amount. They are in the values field.
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